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As the dog days of summer bear down on us, things
are remaining "hot" with PCLinuxOS. Recently,
we've seen the release of the quarterly update for
the different desktop flavors of PCLinuxOS. These
bear a new naming schema, where "2010.07" refers
to the 2010 release, from the seventh month, or July.

Additionally, PCLinuxOS has managed to garner
much well­deserved acclaim in various reviews of
Linux distributions. Of course, the added benefit of
this recent flurry of good reviews is the influx of new
users to the PCLinuxOS ranks.
In fact, we are seeing lots of new users in the
PCLinuxOS Forum. We are seeing users moving to
PCLinuxOS from the various versions of Windows.
We are seeing users moving to PCLinuxOS from OS
X. And we are seeing users moving to PCLinuxOS
from other Linux distributions. As PCLinuxOS
receives all of these new users, it's important to
remember not only our Forum manners, but to also
make them feel welcome to our Linux home.
This month, I'd like to announce that Meemaw will
fulfill the role of a second assistant editor for the
PCLinuxOS Magazine. She has been an invaluable
asset over much of the past year, helping with
articles, editing and layout of the magazine. Without
her assistance, I'm not sure I'd have had the time or
energy to focus on (or implement) the improvements
in The NEW PCLinuxOS Magazine that you have
seen over the past year. So, congratulations
Meemaw, and thank you!
We have plenty of items that we hope will keep your
interest this month. First, I conclude my series on the
Xfce 4.6.2 desktop environment. I provide Xfce
4.6.2: The Xfce Settings Manager, Part 3 article,
as well as Xfce 4.6.2: Customize Your Xfwm
Theme and Xfce 4.6.2: Customize Thunar's
Context Menu. Meemaw continues her look at the
OpenOffice office suite, with a look at OpenOffice
3.2: Calc.

Speaking of article series, critter continues his most
excellent series, with Command Line Interface
Intro: Part 11. Eronstuc continues his series on
computer programming languages, with Computer
Languages A to Z: Modula2. djohnston continues
his series of articles that take a look at alternate
operating systems, with his Alternate OS: Haiku,
Part 2 article.
Leiche walks us through using jMencode in his
Video Encoding: Step­By­Step article. Xyus gives
us another installment of Game Zone, with his
Game Zone: World Of Goo article. Wamukota lists
the reasons he feels that Linux IS Ready For The
Desktop. I detail yet another Firefox add­on, with my
Firefox Add­ons: Xmarks Marks The Spot article.
And, we have three new testimonials this month.
And Timeth provides us an Inkscape tutorial, to help
us learn how to clip objects, in his Clipping Objects
Together To Create Cool Graphics in Inkscape
article.
Of course, ms_meme's regular columns, Forum
Foibles and ms_meme's Nook are back, as well as
georgetoon's Double Take & Mark's Quick Gimp
Tip. And, this month's cover is by Timeth,
commemorating Spain's win in the FIFA World Cup.
Until next month, I wish you peace, happiness,
serenity and tranquility.

Welcome From The Chief EditorWelcome From The Chief Editor

http://pclinuxos.com/?page_id=7
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by Alain Baudrez (Wamukota)

I've read many postings and rants about Linux not
being ready for the desktop, while my experience
tends to state the opposite. Linux is – and has been
for the last couple of years – ready for the desktop.
It all boils down to the type of audience you speak
to.
Windows has been developed with the industry in
mind. That implies that you have a group of well­
trained IT guys who do the Windows laundry while
you, at your desk, can work without bothering
whether the latest patches are applied, the AV is up
to date, Anti­malware filters are in place, …
But let's look at a typical home user.
What does 'Jane Doe' do (or would like to do)
with her computer?
* Browse the web
* Send & Receive eMail
* Instant Messaging
* Twitter
* Skype
* Rip audio to MP3
* Play and organize her music collection
* Transfer music between PC and MP3 player
* Upload pictures/movies from a digital camera
* Red eye removal and minor enchantments of
pictures

* Watch movies on DVD
* Edit her own video recordings

* Burn CD/DVD
* Write a few letters
* Keep budget in check with a simple spreadsheet
* Make small posters for festivities
* Create and maintain a website
* Play games
* Install new software
* Interact with wireless networks and bluetooth
devices

Alain Baudez, a.k.a. Wamukota
Those actions seem familiar and they 'can' all be
done with the pre­installed Windows. Correction. Not
if you stick to your pre­installed Windows. For most
of those actions, you need to buy expensive
software, which for most of us is not tax deductible.
Looking at that list through Linux glasses, with the
exception of some games, all can be done using a
free modern state of the art Linux distribution.
So, Linux clearly has the edge on Windows here,

and Windows being pre­installed anyway, we always
have a fall­back for the few things that can not be
done through Linux. Should Windows not come pre­
installed, Linux would struggle, especially in the
games area. But the simple fact that Windows
comes pre­installed plays into the hands of a dual­
boot Windows/Linux solution.
What should the same Jane Doe not have to do?
* Tamper with the system
* Bother about the legal status of the OS
* Fight malware and other nastinesses of the

Internet
* Be responsible for maintaining system integrity

through updates and patches
* Buy new hardware every 3 years to be able to

accommodate the latest imposed upgrades
* Buy expensive software
When using Windows, this is just what Jane Doe has
to do to keep her box running. The problems and
performance loss inherent in the Windows system
are a far cry from the fun and joy of having a
computer she expected.
A modern Linux distribution is much simpler to
maintain. Its concepts prevent a user crippling the
system by disallowing her to venture in typical
system folders. There are no legal issues. The
distribution can be copied, passed on, etc., without
problems.
There are almost no risks that viruses or malware
will cripple the system.

Linux IS Ready For The DesktopLinux IS Ready For The Desktop



5

Installing software is free and comes from a certified
single set of servers.
Linux runs much longer on the same hardware.
All in all, Linux has the edge on Windows here too.
The general consensus is that Linux is hard to
install. One cannot expect an average user to install
Linux to dual­boot with their current Windows
installation.
In fact, Linux is no harder to install than any other
Operating System. But since Windows comes pre­
installed, all the user must do is to activate the end
user license to get going. The only thing we – Linux
users ­ must do, is to install it on their computer in
dual­boot mode, and give them a few how­tos on
how to work with it. Isn't that something we all have
done in the past many times?
Linux is ready for the desktop if you never hear back
from those converted users again. It works and just
keeps on working, something that cannot be said
about the other pre­installed operating system.

Screenshot ShowcaseScreenshot Showcase

The NEW PCLinuxOS Magazine
Created with Scribus 1.3.7 Posted July 28, 2010, by cidtux, running Xfce

Linux IS Ready For The Desktop

http://pclosmag.com
http://www.scribus.net
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by Paul Arnote (parnote)

Over the past couple of months, we've been taking a
close­up look at the Xfce Settings Manager. This
month, we finish up the series on the Xfce Settings
Manager, taking a look at the last group of settings
that are available.

Removable Drives and Media
The first tab under Removable Drives and Media,
Storage (bottom of previous column), allows you to
set how Xfce handles options for removable drives
and media. Under Removable Storage, the options
should be fairly self explanatory. Under Bland CDs
and DVDs, you can check the box to cause Xfburn
(the default optical disk burning program in Xfce) to
open when you insert a blank CD or DVD. The
screen shot above shows the default settings in
Phoenix 2010.

Under the second tab, Multimedia, we can set up
how Xfce handles specific types of media when they
are plugged in or a disk is inserted. You will most
likely have to make some changes here, as Totem is
not installed in the default installation of Phoenix
2010. You can either install Totem from the

repository (but be aware that it will pull in quite a few
Gnome dependencies), or you can install another
multimedia playback program (watch which
dependencies are pulled in), or change from Totem
(in the screen shot above) to gxine for video, and
Listen Music Player for audio CDs. If you like to sync
your portable music player with your MP3 collection,
you also may want to install a program from the
repository, via Synaptic, to handle or manage the
transfer of music between the files stored on your
computer and those on your portable music player.
Activating the "Portable Music Players" setting is as
easy as checking the box in that category, and
supplying the name of the program you are using to
manage that portable music player.

The third tab of Removable Drives & Storage,
Cameras, allows you to set up how Xfce handles the

Xfce 4.6.2: Xfce Settings Manager, Part 3Xfce 4.6.2: Xfce Settings Manager, Part 3
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importing of photographs from your digital camera,
when it is connected to your computer.

The fourth tab, PDAs, allows you to specify how the
information on your PDA and the information on your
computer are synced, as well as which program
you'd like to use to accomplish that task.
If you are mobile with your laptop, there may be an
occasion where you need to hook up to a printer (not
necessarily your own). If this is you, then this, the
Printers tab, is for you. Check this box to run the
gnome­printer­add program whenever a printer is
connected to your computer. This will aid you in
establishing that connection, and helps tell Xfce how
to manage printing requests. You will have to also
set up the printer in the Printing settings of Xfce, asw
well as setting that printer up in PCLinuxOS Control
Center.

In the sixth and final tab of Removable Drives &
Storage, Input Devices, you can control any special
actions that may need to take place when you attach
a USB Keyboard, USB Mouse, or a tablet is
connected to your computer.

Session and Start Up

In the General tab of Session and Startup settings,
you can select if you want to see the Session
Chooser, which allows you to resume a previous
session when you log into Xfce. You can also select
if you want your current session to be automatically
saved when you log out, or if you want to be
prompted.
Under the "Splash" tab, you can select the splash
screen that's displayed when the Xfce desktop

Xfce 4.6.2: Xfce Settings Manager, Part 3
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environment is loaded. The default in Phoenix 2010
is "none."

The Application Autostart tab allows you to manage
which programs are started automatically when you

start up Xfce. If you change your mind about a
program auto­starting, you can either come to this
screen and uncheck the box, causing Xfce to ignore
that program when it starts. You can also remove
that program from the list altogether, by highlighting
(clicking) on that program and selecting the
"Remove" button near the bottom left of the window.
Similarly, if there is a program you want to start
whenever Xfce starts up, you can select on the
"Add" button. Follow the screen prompts, and you'll
have your program added to the list in no time at all.

The Session tab allows us to specify which key parts
of your currently running session can be saved when
you log out. You can select an item from the list,
double click it, and change the restart style.
Under the Advanced tab, we can tell Xfce to launch
either Gnome or KDE services when it starts. We
can also select to manage remote applications, by
selecting that option as well.

Settings Editor

The settings editor allows you to directly edit many
of the Xfce settings on your computer. Most of these
settings are made in other areas of the Xfce Settings
Manager. So, unless you really know what you are
doing, or if you are feeling particularly adventurous,

Xfce 4.6.2: Xfce Settings Manager, Part 3
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you can edit the Xfce settings here, en masse. One
other feature that you may find useful is to "lock" the
settings here, so that they cannot be changed until it
is first unlocked. This is particularly useful on a
computer with other users, or with less technically
savvy users, to prevent them from making system
wide Xfce settings.
We will skip the next icon in the list of Xfce Settings
Manager, since it merely launches another instance
of the Xfce Settings Manager.

Window Manager

Style, the first tab under the Window Manager
settings, allows us access to changing the style of
the Xfce window decorations, which are managed by
the xfwm window manager. The default settings in

Phoenix 2010 are reflected in the above screen
shot. We'll talk more about xfwm themes in another,
separate article about how to make your own
custom xfwm theme.

Under the Keyboard tab, we can define keyboard
shortcuts for interacting with the Xfce windows. For
example, I have become accustomed to using Alt +
Spacebar to access the window operations menu
(upper left corner of the window, on the title bar of
the window). This is definitely a throwback to my
days as a Windows user. Similarly, I've defined Alt +
F4 as the key stroke combination that closes (exits)
a window. To set the keyboard shortcuts, simply click
on the item you want to define, then hit the key or
key combination you want to use to activate that
window setting. And window settings exist for
changing between the virtual desktops on your
system as well. Scroll through the list to see all the
options you can access from the keyboard. Just be
careful when you are defining the keyboard
shortcuts that they don't conflict with other

commonly used keystroke combinations (like Alt + S,
which is commonly used within individual programs
to save a file).

From the Focus tab of the Window Manager
settings, you can control how Xfce handles window
focus changes. The screen shot above represents
the default settings in Phoenix 2010. Also, the
settings should be fairly self explanatory, so I won't
belabor them here.
On the Advanced tab (first graphic, next page), you
can set additional options for how Xfce manages
windows. Under Window snapping, you can tell Xfce
to "snap" your windows to the screen border when
you slowly drag a window to a chosen screen
border. You can also tell it to snap the window to the
edge of other windows.

Xfce 4.6.2: Xfce Settings Manager, Part 3



10

Under Wrap workspaces, you can tell Xfce what to
do when your cursor gets to the edge of the screen
(wrap to the previous or next virtual desktop), or if to
move a window to an adjacent desktop as it is
dragged off the edge of the current desktop. This
allow you to drag a window from the first desktop, all
the way to the fourth desktop, if you choose. And
here's a bonus tip: you can also do this from the
pager plug in (typically the lower right corner of the
bottom panel). Just click on the icon representation
of the program you want to move, and drag it to the
desktop you want it to appear on. Release the
mouse, and your program will be happily displayed
on the new/different desktop.
From the Box move and resize settings, you can tell
Xfce to hide the contents of windows that are being
moved or resized. This is a particularly helpful
setting if the computer you are using Xfce on has
limited video RAM, a slower processor, or both.

Finally, the Double click action allows you to set the
action Xfce will take when you double click on a
window's title bar. The default value is to maximize
the window. I've changed the behavior on my copy
of Phoenix 2010 to Shade window, due to how I tend
to work with Scribus when I'm laying out the
magazine (so I can get some of Scribus's child
windows out of my way temporarily when I'm
working in another window).

Window Manager Tweaks

From the Cycling tab of Window Manager Tweaks,
you can set how Xfce cycles through the available
program windows you may have running. Typically,
most users will want to set up the Alt + Tab key in
the Keyboard tab of the Window Manager window to
cycle through the available program windows. This
tab allows the user to further tweak that Xfce
behavior.

Under the Focus tab, you can further tweak and tune
how Xfce manages the change in window focus.
Probably one of the more important setting here is
determining how a window raises itself when called.

Xfce 4.6.2: Xfce Settings Manager, Part 3
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You can opt for the window to be brought to your
current workspace, switch to the window's
workspace, or do nothing at all.
The Accessibility tab (previous page) gives you even
more options to further tune how Xfce manages the
windows on your computer. Probably the most
important setting here allows you can define the key
to use to grab and move windows when the title bar
of the window isn't visible, or when the title bar is
butted up against the top edge of the window.
Netbook users, as well as other users who have
limited screen real estate, will find this particular
feature useful. Just press the specified key (default
is the Alt key), and drag the window until what you
want to see is visible.

The Workspaces tab allows you to set extra options
for how Xfce manages and allows you to access
your workspaces, a.k.a. virtual desktops. You can
set to allow the mouse wheel to switch desktops

when you hover over the pager plug in and rotate
the mouse wheel. You can also tell Xfce to
remember and recall the previous workspace when
switching via keyboard shortcuts. If you have a
keyboard shortcut defined for switching desktops
(e.g., Ctrl + Alt + Left Arrow or Ctrl + Alt + Right
Arrow), you can tell Xfce to go to Desktop 1 from
Desktop 4 when you press Ctrl + Alt + Right Arrow,
or from Desktop 1 to Desktop 4 by pressing Ctrl + Alt
+ Left Arrow.

With the Placement tab, you can control how Xfce
places new windows on the screen. The above
screen shot shows the default settings in Phoenix
2010. The settings, I believe, are self explanatory.
The last tab, Compositor, allows you to enable or
disable the built­in Xfce display compositing. No, it's
not quite up to the compositing abilities of KDE 4 or
Compiz Fusion, but it does have a few options for

you to select. You can certainly disable display
compositing, which is especially useful if you have
an older computer with minimal amounts of video
RAM.

Workspaces
Under Workspaces (next page), we can define a
couple of different settings. First, in the left hand
pane of the window, we can specify how many
workspaces, or virtual desktops, we want to use.
The default is four workspaces. If you want, you can
also rename the workspaces.
On the right hand pane, you can set up window
margins. These are areas of the screen where Xfce
will not place a window. This is useful, for example, if
you have a Conky script running and don't want to
cover it up with windows on your desktop.

Xfce 4.6.2: Xfce Settings Manager, Part 3
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Conclusion
There you have it – a complete look at all the
options available to you via the Xfce Settings
Manager. Thanks to these settings, Xfce has a lot of
configuration options, while maintaining its
lightweight desktop environment status. If you use
Xfce, you owe it to yourself to explore the
configuration options that have been covered in this
article, as well as the two previous articles in the
series. It's unlikely that you will cause any
permanent damage, although it is possible. But now,
at least, you can delve into these configuration
settings with a bit more knowledge of what these
individual settings allow you to do.

Screenshot ShowcaseScreenshot Showcase

Posted by OrdiDoc, July 14, 2010, running KDE4

Xfce 4.6.2: Xfce Settings Manager, Part 3
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by bluejay
Howdy!
Well, let's see. I've been at this Linux bit for quite a
few years, starting with Mandrake 8.1, which I
purchased new in a box. (That's about 8 or more
years ago.) It was a lot of fun tooling around with this
geeky new OS back then, and I was thrilled with the
concept of a community surrounding it (and Linux in
general). The OS was pretty amazing too!
I used Mandrake for a year or so, but eventually
moved to RedHat because I saw it as a "big boy's"
Linux and more "hard core" and challenging.
Then, Fedora came out and I used that for many
years, until one day, (out of nothing more than
boredom and curiosity), I decided to give Ubuntu a
try and was instantly hooked for the next several
years.
During all this time I played around with about a
dozen other distros, from Debian to Gentoo to
FreeBSD. Although I'd see PCLinuxOS pop up on
the radar from time to time, I really never paid much
attention, until the other day when I noticed that it
had reached the #2 spot on a certain major Linux
site. I also read a number of glowing reviews about
it. So, the other day I decided to give it a try. I found
that not only was it gorgeous, but it contained
everything I needed and nothing I didn't. It was
perfect.
My particular interest in it revolves around the
server­end of things, and it seems to have a

wonderful array of server features built­in. That's one
of the things that impressed me. BIND, Host
definitions, FTP, Mail, etc.
Well, That's my story and I'm sticking to it. Anyway,
I'm glad to be here and looking forward to fitting into
the community here!.
­ BJ

It's easier than e=mc2

It's elemental
It's light years ahead

It's a wise choice
It's Radically Simple

It's ...Want to keep up on the latest that's
going on with PCLinuxOS?

Follow PCLinuxOS on Twitter!
http://twitter.com/iluvpclinuxos

Testimonial: Greetings from a New PCLinuxOS UserTestimonial: Greetings from a New PCLinuxOS User

http://www.pclinuxos.com
http://twitter.com/iluvpclinuxos
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by Paul Arnote (parnote)

It may sound difficult, but creating your own custom
Xfce Window Manager (xfwm) theme is probably
one of the easiest customizations you can do on
your Xfce installation.
From the Xfce Settings Manager, going in to the
Window Manager applet allows you to choose the
xfwm theme to use on your desktop. This xfwm
theme controls the appearance of your window
decorations, including the titlebar, the window
borders, and the shade, minimize, maximize, close,
sticky, and system menu buttons. Here's what you
will see when you open the Window Manager applet:

Since we've already covered the Window Manager
applet in the Xfce 4.6.2: Xfce Settings Manager
Article elsewhere in this issue, we won't rehash it

here. Of the seven included xfwm themes included
in the default installation of Phoenix 2010, I created
four of them. And you can make them as simple or
complex as you like.
Here are six xfwm themes I've created, and they will
serve as the basis for our discussion on creating
your own custom xfwm theme:

From top to bottom, the xfwm themes are called:
AgualemonBlack, Default Blue, Default Chrome,
Default Red, Forum Blue (based on the blue colors
of the default SMF theme in the PCLinuxOS forum),
and Phoenix09 (based on the colors of the default
wallpaper of the Phoenix 2009.4 release).

The Basics: Getting Started
Your xfwm themes are stored in the
/usr/share/themes directory. Each xfwm theme has
its own directory there, bearing the name of the
xfwm theme, and the graphic files for the theme are
stored in the xfwm4 sub­directory. You will need root
access to this folder to make any changes to the
themes that are there, or for storing your custom
theme there. I suggest you store your custom
themes in their own folder somewhere in your /home
directory (mine is just called "themes"), then copying
the entire directory there when you are ready to test
your custom theme. This way, you are not working
as root and not taking the risk of messing up the
other xfwm themes already stored on your computer.
For our discussion, we'll use AgualemonBlack as our
example.

What's Needed
You will need to create a minimum of 42 graphic files
to have a full xfwm theme. These files are small, and
quite easy to make. The files, typically stored as
*.xpm files, are easily created in Gimp. As such, all

Xfce 4.6.2: Customize Your Xfwm ThemeXfce 4.6.2: Customize Your Xfwm Theme
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the tools available in Gimp are at your disposal for
creating your custom xfwm theme.
Because of the small size of the graphics, you will
find it advantageous to use Gimp's zoom tool. I find
that zooming in to the maximum of 800% allows me
to work comfortably with the minuscule graphic files
included in the xfwm themes. Below is an example
of my Gimp window when I'm working on a xfwm
theme graphic. I used the gradient tool, set to
provide a bilinear gradient, using dark gray and
black as my foreground and background colors.

Remember those 42 individual graphic files I told
you that you need? Here's a list of them, along with
the sizes I used for my six themes, with the width
followed by height, in pixels:

You can also add optional graphics to this list for
buttons that have a "toggled" state. Such buttons
would be the "stick" and "shade" buttons. As such,
you can add the following to the above list, bringing
the total number to 48 graphic files for a full xfwm
theme:

shade­toggled­active.xpm
shade­toggled­inactive.xpm
shade­toggled­pressed.xpm
stick­toggled­active.xpm

stick­toggled­inactive.xpm
stick­toggled­pressed.xpm
The best way to get a handle on what the toggled
state of a button does is to see it in action. Switch
you xfwm theme to the Oxygen­Molecule theme,
and select the "shade" button. You can also go to the
/usr/share/themes/Oxygen­Molecule/xfwm4 folder
and take a look at how the graphics files appear.
Also, in keeping with the sizing scheme of the rest of
our xfwm theme, all the buttons will be the same
size. In our case, that will be 20x24.

Xfce 4.6.2: Customize Your Xfwm Theme
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I have also found it makes your life much easier – at
least while creating the xfwm theme – to create and
save a blank button. You can use this blank button
as the basis for all your other buttons, title bar
graphics, and the top left and right corner graphics.
In fact, the image loaded into the previous Gimp
screen shot is of the blank button I used to create
the AgualemonBlack xfwm theme. Just keep
reloading the blank button, make the alterations you
need for each graphic, and resave it with the proper
file name. This also helps keep your graphics
consistent, giving your xfwm theme a much cleaner,
more professional appearance. The only graphics
you will need to create manually are the left, right,
bottom, and bottom left and right window borders,
but those are perhaps the easiest graphics to create.
Here is a collection of all the graphic files combined
into one image, and blown up to 400% in Gimp:

In the top row are, from left to right, the following
active buttons: close, hide, maximize, menu, shade
and stick. In the bottom row, from left to right, are:
title­1, title­2, title­3, title­4, title­5, top­left, top right,
inactive, pressed, bottom left, bottom, bottom right,
left and right.

Since I decided on not changing the window border
colors or titlebar for the inactive windows, the active
window border and titlebar graphics are also
repeated for those items. Also, all the inactive
buttons are the same, as are all the pressed buttons.
This prevented me from having to draw additional
button graphics and window border graphics for
each individual button and window border. Rather, I
just kept renaming the inactive and pressed button
in Gimp (File > Save As...), until I had all of the
required buttons saved. I did the same thing for the
window border graphics.

More Options: themerc
Once you have all of your graphic files created, it's
time to set the "other" options for your xfwm theme.
We do this by including a themerc file in the
/usr/share/themes/name­of­theme/xfwm4 folder of
the xfwm theme, right along with all of your graphic
files. The themerc file is simply a text file that defines
other aspects of the xfwm theme, such as the color
of the active and inactive titlebar text, button
spacing, and other items that we'll cover more
thoroughly here in just a little bit.
First though, here is a sample themerc file, from the
AgualemonBlack xfwm theme:

full_width_title=falsetitle_alignment=centerbutton_spacing=0button_offset=0

title_vertical_offset_active=1title_horizontal_offset_active=0title_vertical_offset_inactive=1title_horizontal_offset_active=0title_shadow_active=falsetitle_shadow_inactive=falseactive_text_color=#ffffffinactive_text_color=#b6b6b6show_app_icon=false
full_width_title: this option is either "true" or "false"
(called boolean) and defines how the titlebar
graphics are arranged. If it is set to "true," the center
titlebar graphic is repeated as many times as
necessary to cover the full width of the titlebar. If you
set it to "false," the center titlebar graphic is repeated
only enough times to appear behind the actual
titlebar text.
title_alignment: specifies the alignment of the
titlebar text. The options are left, right and center.
button spacing: defines the number of pixels
between buttons.
button_offset: allows you to specify how many
pixels to shift the buttons, relative to the
corresponding window border (and not the frame
border). For example, a setting of "10" would move
the buttons at the upper left corner away from the
left window border 10 pixels, and move the buttons
at the upper right corner away from the right window
border 10 pixels.
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title_vertical_offset_active,
title_horizontal_offset_active,
title_vertical_offset_inactive,
title_horizontal_offset_inactive: these values allow
you to shift the titlebar text on the specified window
titlebar (active or inactive) the specified number of
pixels. Except in special cases, the value is usually
"0" or "1" pixel.
title_shadow_active, title_shadow_inactive: set to
either "true" or "false," this value determines whether
or not the text on the titlebar is drawn with or without
a shadow.
active_text_color, inactive_text_color: using a six­
digit hex color code (the same as used in HTML), it
specifies the color for the titlebar text on the active
and inactive window titlebars. If you need to know a
specific color code, open up Gimp, select the color
you want from the Gimp palette color selection box,
and pay attention to what Gimp specifies as the
HTML color code. You must always precede the six­
digit hex color code with the "#" symbol. And, for
what it's worth, black is #000000, light gray is
#cccccc, and white is #ffffff.
show_app_icon: another boolean setting. If you set
it to "true," the application's defined icon will replace
the menu button. Likewise, if you set it to "false," the
application's icon will not be displayed, and the
menu button will be displayed in its place.
There is another setting that we have not employed.
It's called button_layout. It defines the order of
button layout on the titlebar of the window. Use
caution with this, as defining the button layout will
eliminate any choice the end user will have, and

should be avoided unless absolutely necessary. With
that in mind, here is how the button_layout settings
go:
# button_layout :# O = Option menu# T = Stick# H = hide# S = shade# M = maximize# C = close# | = titlebutton_layout=OT|SHMC
There are additional things you can do, like make
your xfwm theme "pick up" the colors from the Gtk+
theme. We won't be going into all of that here, as it's
a quite involved (albeit relatively easy). If you are
interested in exploring how to do this, you can check
out the xfwm theme how­to page from the Xfce Wiki.

Conclusion
As you can see, creating your own xfwm themes is
actually quite easy. Also, there are enough options
available to allow you virtually unlimited creativity. So
unleash that creativity, and get started creating and
tweaking your own custom xfwm theme. You have
the opportunity to make your Xfce desktop
experience uniquely yours, without too much trouble
at all.

PCLinuxOS Magazine Mailing List:
http://groups.google.com/group/pclinuxos­magazine

PCLinuxOS Magazine Web Site:
http://pclosmag.com/

PCLinuxOS Magazine Forums:
PCLinuxOS Magazine Forum:

http://pclosmag.com/forum/index.php
Main PCLinuxOS Forum:

http://www.pclinuxos.com/forum/index.php?board=34.0
MyPCLinuxOS Forum:

http://mypclinuxos.com/forum/index.php?board=157.0

Reach Us On The Web

Xfce 4.6.2: Customize Your Xfwm Theme

http://www.enkiconsulting.net/
http://groups.google.com/group/pclinuxos-magazine
http://pclosmag.com
http://pclosmag.com/forum/index.php
http://www.pclinuxos.com/forum/index.php?board=34.0
http://mypclinuxos.com/forum/index.php?board=157.0
http://www.xfce.org/xfwm4-theme-howto/


18

View the Double Take
Answers on Page 46.

If you're like me and have used anynumber of photo editing applications overthe years, you're aware that most allowyou to set the maximum number of undolevels at 99 or 100. The Gimp is differentand a bit more sophisticated. It allows youto set the maximum amount of memory touse for undoes and set the minimum undolevel. The default setting is a minimum100 undo levels which is more thanenough for anyone. And The Gimp allowsyou to use up to 64 megs of RAM forundoes per image. If you exceed this
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memory allocation, theoldest undo points will bedeleted. If you're luckyenough to have a a lot ofmemory, simply up yourallocation if you think you'll need it. Youcan select undo in one of three ways. Fromthe menu, select Edit > Undo. Or, use thekeyboard shortcut of Ctrl + Z. But by far,the most helpful method is the UndoHistory Dialog. This tool panel is on theright side and its icon is a yellow arrowpointing to the left. This handy tool panelgives you a thumbnail of each editing stepthe user has completed. You can jump

backward as manysteps as you wantsimply by clicking onthe thumbnail of thatstep. Each step islabeled as to theediting action thatwas taken. So, don'tworry about makinga mistake whenediting in Gimp!You've got plenty ofundoes available!
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­Mark Szorady is a nationally syndicated cartoonist with georgetoon.com. He blogs at georgetoon.com/blog. Email Mark at georgetoon@gmail.com.
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by Peter Kelly (critter)

A handful of the more useful commands
So far in this series, we have looked at most of the
important aspects of working on the command line.
This time I want to spend a little time looking at
some of the more useful utilities available in a Linux
distribution.
This is not meant to be an exhaustive list. There are
far too many such commands available for that, but
is a look at those utilities that you should find in
almost any distribution, either installed by default or
available from their repositories.
These are commands that you may not use every
day, but you will find invaluable when you do need
them. They are commands that I have not already
covered, or that are deserving of a little more
explanation. I am not going to cover every possible
feature of the commands. The manuals are there for
that, but I hope to cover them in enough detail to
give a good understanding of what the command is
capable of.

apropos {string}
Ever been stuck at the command line, knowing what
you want to do, but can't for the life of you remember
the name of the command? Of course, we all have,
and this is where this command saves the day. It
searches a database of manual page descriptions
for things that match the string that follows:

at {options}{time}{date}
This enables you to have commands executed at a
particular time. Where cron is used for running
repetitive tasks at a particular time or frequency, the
at command is useful for one­off tasks. To use it, the
atd service must be running. This can be determined
by issuing, as root, the command/sbin/service atd status
It may be started, if necessary, with the command/sbin/service atd start
You start the command by typing at followed, by a
time, and optionally, a date. If the ­f option is
specified with a file name, then the list of commands
to be executed are read from that file. Otherwise,
you a prompted to enter them at the terminal. Entry
is terminated with Ctrl­d.
The way time is specified is rather unusual. It may
be entered in the format 15:30 for a 24 hour clock,
or 3:30pm for a 12 hour clock. You may also specify
time as midnight, noon, teatime (4:00pm) or now +
2 hours, and you can add today or tomorrow. Date

takes the format March 15 or Mar 15. The year is 4
digits, e.g. 2010. You can simply specify a day, Sat
or Saturday. An increment can be added to any part
of the time date string.
When commands are executed any output or error
messages are mailed to the user, but you must have
the sendmail service installed and configured to
make use of this. Instead, most users will want to re­
direct the output to a file.
Each set of commands is given a unique job
number, and pending jobs can be listed with the
command atq. Jobs can be removed from the queue
with the command atrm job­number.

basename {name}{suffix}
This command is used to remove all leading
directory names and, optionally, the suffix from a
fully qualified file name. So, basename/home/jane/scripts/myscript1.sh would
return myscript1.sh, and basename/home/jane/scripts/myscript1.sh .sh
would return myscript1. You will find this command
invaluable in scripts.

bc
bc is a command line calculator. That much is
basically true, but it is also a gross understatement.
It is a complete, compilable language, similar to C,
which is capable of unlimited precision arithmetic. It
has an extensive library of mathematical functions,
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which you can include with the ­l option, and you
may define your own functions. Most people
however, will use it interactively on the command
line, or use it in a script to do a quick calculation or
conversion.
To use bc on the command line, you may simply
type bc and you will be greeted with a banner
declaring version and licensing information, (this can
be suppressed by using the ­q option ), and a
prompt.

You can then simply type in expressions, such as
2+3 or 3.1416*6, and the result will be echoed to the
screen (stdout). To end the session, type quit or
ctrl­d.
If you don't use the ­l option, which will use long
floating point numbers, then integer arithmetic is
used. In the bc language, the scale of precision is
zero, which means that zero decimal places are
displayed. This can be changed by setting the
variable scale. Using the ­l option sets this value to
20 by default, which displays 20 decimal places.
Note that if you use a value in an expression with
more decimal places than the current value of scale,
then that number of decimal places is used to
display the result.
If you intend using bc then, as you don't need to
know the version stuff every time, and bash can
handle integers just fine, then you may want to put
an alias in your .bashrc file.

alias bc=”bc ­lq”
The bc command is often used in pipelines and
redirection, as in the following examples:
echo 3.1416*2.5 | bc ­l
bc <<< 2^32
Or, the expressions can be read from a text file:
cat > sums
2+3
s(1.34) #sine 1.34 radians
scale=5
7/3
quit
Comments are allowed, and are preceded by a hash
#. Without the quit statement, bc would wait for more
input from stdin.

The bc command can work in any base from 2 to 16,
but defaults to base 10.

To change this use the variables ibase and obase
for the input and output bases. This is extremely
useful if you need to convert between binary,
hexadecimal, octal and decimal. The following bash
script converts decimal to hexadecimal:
#!/bin/bash#d2h.sh convert decimal to hexadecimal
if [ $# != 1 ]; thenecho "Usage: d2h decimal­value"exit 1fiecho “ibase=10; obase=16; $1" | bc

Should you want to edit this script to reverse the
operation, hex to decimal, be aware that obase must
be in ibase format:
ibase=16; obase=A
And hexadecimal letters must be in uppercase,
since lowercase characters are reserved for bc
variables. You could pipe the value through the awk
toupper function, or use the tr command before
passing it to bc to ensure that this is so.

cksum {files}
If you are transferring or compressing files, you may
find this command useful. It calculates a cyclic
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redundancy (CRC) value for all files specified on the
command line. This value can later be used to check
the integrity of the file.

clear
Clears the terminal screen, nothing else. Simple, but
essential.

comm {option}{file_a}{file_b}
When you need to know how similar two files are,
use this command. The output is is in three columns:

lines only in file_a, lines only in file_b and lines
common to both files. There is an option to suppress
certain columns by listing their numbers with no
spaces. ­12 would suppress columns 1 and 2, listing
out only lines common to both files.

cut {options}{files}
You can use this to chop out fields of data from files
specified, or from stdin. The options allow you to
specify a list of bytes ­b, columns ­c or fields ­f to
cut. If ­f is specified, the default delimiter is the tab
character, but this can be changed with the ­d
option. ­s with ­f suppresses lines with no delimiters.

If the file contains multi­byte characters, you have
the ­n option to avoid splitting them. The list of fields
can be comma separated values, or ranges 2­5.

Here, we have asked for a list of usb devices
available on the system. The delimiter is a space
character, and we are not interested in fields 5 & 6.
As the delimiter is a space and the name contains
spaces the final range, 7­20, has been made wide
enough to catch all words.

df {options}{device_name}
This is a handy little utility to report disk free space.
If name is omitted, then all mounted file systems are
reported. Name can be a device name, such as
/dev/sdb1, or a mount point, such as /home. If a
directory name is used, then the report is of the
entire file system on which that directory is mounted.
Options include:
­a shows all file systems including 'dummy' files

systems such as /proc­i to show inode usage rather than byte usage.­h reports in human readable form e.g. 15G­t only include type file systems ­t ext4­T include the file system type in the report­x exclude listed file system types.
If you are using PCLinuxOS you will find that you
have an alias to the command:
alias df='df ­h ­x supermount
This makes the report human readable, and doesn't
probe supermount file systems. Supermount is a
fake file system used to handle removable media,
such as CDs and floppy disks.
It is important to monitor drive usage as a full drive
can cause strange problems, particularly if an
application or script has not been crafted in such a
manner as to trap this.
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dirname {name}
The opposite of basename, this strips away the file
name in it's entirety, by searching for the last /.
dirname /home/jane/scripts/myscript1.sh would
return /home/jane/scripts.
If there are no leading directories, as in
myscript1.sh, then . (a period specifying current
directory) is returned.

du
Reports the disk usage or the space used by a
directory, the default is the current directory.
This is one of the 'core utilities.' You should find it on
any Linux system, as it is considered essential,
although most people will use few of its twenty or so
command line options. If you are using PCLinuxOS,
then you will have an alias to du that adds the ­h
option automatically, to make the output 'human
readable'. Other options that are often used include:
­c Print a grand total at the end of the output­s Summarize only. Outputs just a total­x Limit the count to files on one file system only
­­max­depth=n Restrict the report to directories n
levels deep. note that this is a 'long­option' and is
preceded by two hyphens not one.

file {file name}
When you want to know what type of data is in a
particular file, use this command.

fmt
If you have a plain text file that you need to fit in a
restricted screen or paper space, then this command
does a nice job of it. It endeavors to retain as much
of the original files formatting as possible. Spacing
and indentation are kept intact wherever possible,
and line breaks are done at the ends of sentences.
The most useful option here is ­w to set the width.
fmt ­w 36 a­text­file will output the file in a single 36
character wide formatted column.

free
When your system seems particularly slow or
sluggish, you should you should use this command
to check your memory usage. The options ­b ­k ­m
& ­g display the output in bytes, kilobytes megabytes
or gigabytes respectively. The default is kilobytes.

Normally, you have two types of memory: physical,
and virtual or swap space. When an application is
started, the kernel allocates it some memory to work
in. Additionally, the application may request more

memory as demand from the user increases. Data
can be stored in a cache, in readiness to be
operated on by the application, and temporary data
and results are stored in buffers. For example, when
a CD burning application is writing data, then that
data is read from the hard drive much more quickly
than it can be burned to the CD, and so the data is
stored in a buffer where it can be accessed as
required.
When the kernel has exhausted its supply of
physical memory, it begins to 'swap out' some of the
allocated memory contents to virtual memory to
relieve the situation. Swap is much slower than
physical memory, and so the result is that the
machine slows down.
If you experience high swap memory usage, then
something needs to be done.
You can shut down some applications, which will
help, or you may have a rogue process hogging
resources, remember orphans and zombies from
when we discussed processes? If you need to track
down which processes are using the most memory,
use a tool like the command top. It may even be that
you need to fit more memory to the machine if you
regularly get this situation.
In the screen dump above, the top line is the
physical memory, the bottom line swap and the
middle line is the amount of memory used or free,
without that which is promised to buffers and cache
storage.
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fuser {file or file­system}
Have you ever tried to umount a usb or other type
of external drive, only to be told that it is busy with
some process or other? Although you thought that
you closed down all of the files on the device, the
system thinks otherwise, and it refuses to let you
safely remove it.
This command is what you need at times like this. It
lists the process ID (PID) of all active files on the
specified path. Now, path here can be a path name,
a mounted directory, a block device such as
/dev/sdb1 or even a remote system such as an ftp
server.
For our usb drive example, we need to specify the
­m option to tell the command that what follows is a
mount point or block device. The PID is not very
informative, so we specify the ­v option to get
verbose output that tells us what the file(s) actually
is (are). As we want to remove the device, we need
to kill the process(es), so we add the ­k option. This
however, is potentially dangerous, as we have
forgotten what the file is. How can we be certain that
we have finished with it and saved any changes? To
be safe, rather than sorry, we can add the ­i option
that interactively asks for confirmation before killing
each process.
fuser ­mvki /media/usb/ This will list any files
open on the device and prompt you to delete them
or not.
Once we have closed all the open files, we can
resume the umount command.

gzip & gunzip
There are many file compression tools around, and
gzip is one of the best of them. This one is so tightly
integrated into so many Unix/Linux practices and
processes that knowing how to use it is a must if you
are going to spend any time on the command line.
Using it is easy anyways, so why not? Compressed
files save on storage space, not such an issue these
days, and transfer much more quickly over slow
transmission lines and networks.
The easiest way to use this is simply gzip file name.
Unusually, this changes the original file and does not
create a new one. The file is compressed and .gz
appended to its name. Among the options you can
pass to it are:
­d decompress ­­ this is exactly the same as gunzip
­s suffix to change the default gz to something
that you prefer
­n where n is not the letter n but a number from 1 to
9 that will determine the amount of compression to
be applied. 9 is the maximum compression. You may
also use ­fast or –best in place of ­1 and ­9. The
default here is 6, which is fine for most uses.
­r if you pass a directory to the command, then this
will recursively work on the files it contains.
Multiple files may be passed on the command line
as arguments.

head
head is useful for displaying just the first few lines of
a file. By default, 10 lines are shown, but this can be
changed by passing the number of lines required as
an option, e.g. head ­15 logfile. See also tail.

kill
When you find that a process is misbehaving and
you want to end it, then use this command.
Obviously, you must be the owner of the process or
have superuser privileges to do this.
To use it, you send it a signal as an option, and
provide the PID of the process(es) to be dealt with. If
no signal is specified, then the default signal TERM
is used. The signal can be specified as a number or
as a name. The TERM signal is number 15 and is
named SIGTERM. Some processes can trap the
signal being sent to them as a sort of survival tactic,
and stubbornly refuse to die. In these cases, use
signal number 9 , SIGKILL this cannot be caught,
but it is rather drastic and a more graceful closure is
to be preferred.
Kill ­9 1729 will stop process number 1729 in its
tracks.
To get a list of all signal numbers and their names,
use the ­l option.
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less
To display text files on a terminal screen in Unix, a
command named more was created (pressing the
space bar showed more text). It was quite limited
and fairly clumsy to use, with most of its commands
being based on the vi editor.
Soon, a much more capable alternative came on the
scene and, perversely, was named less. This is one
of those commands that has far too many options for
me; I like to keep things as simple as possible. If
there is something that you want to do with a text
file, then less is probably capable of doing it.
Usually, I just want to look at the text and scroll back
and forth. For this, it is excellent.
Type less textfile and the beginning of the file will
be displayed on screen. Press f or the space bar to
go forward, b to go backward or use the arrow keys
to navigate around. Press q to quit. What could be
simpler?
To search within the file, type a forward slash,
followed by the word or pattern that you want to find
and press return. Use ? In place of the slash to
search backwards.
For me, this suffices. If I want to do more, I use an
editor.

namei
Trace a path name to its conclusion.

This rather unusual command is actually quite
useful. On my system, I have the 'all bells and
whistles' version of vi installed – vim.
When I type /bin/vi on the command line I am given
an editor that happens to be vim. If I use the which
command to find out what will be executed by typing
vi, I get this:
which vi/usr/bin/vi
So what's going on here?
namei will follow the path name, through any links,
and display a character to describe the type of each
file found. These characters are:­ regular fileb block devicec character deviced directoryf: the path name currently being worked onl links socket? an error
Typing namei /bin/vi gives the following output:

This shows the links that the command /bin/vi has
gone through, and that I am really executing
/usr/bin/vim­enhanced.

ps
Display information about processes running on the
system.
This is how you can find out which processes are
using system resources, who owns them and their
PID's.
Armed with this information, you can deal with any
processes that step out of line or that are just taking
up space. The output can be quite long, and you will
find that this command is often used with grep to
filter the information, and then piped to less to give
time to read it.
The command comes with enough options to satisfy
even the most enthusiastic systems administrator,
but us mortals can mostly get the results with just
four.
a list all processesu include the username of the owner of the processx include processes that are not associated with a

terminalf display a tree like structure to show parent/child
process relationships

A leading hyphen is not required with these options
and should not be used, as it can change the
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meaning of some options. The output is a series of
fields displayed in columns, and what is output is
dependent upon which options are used.
The first line of output contains the column headers,
which describe what follows below. The interesting
ones for us are:
USER process owners user namePID process ID number%CPU amount of processor time used%MEM percentage of physical memory used by the

processVSZ virtual memory size in KBTTY the terminal on which it is running, if any.
STAT process status which can be one of the

following:
D in a deep, uninterruptable sleepS sleeping or waitingR running or in the queue to be runT stoppedX dead, you should never see this as it

should have been removed from the
process queueZ zombie ­ you should remove these

Additionally, you may also see alongside these
codes one or more of the following:

N nice, low priority< high priorityl multi­threadedL locked pages in memory

s session leader+ foreground process
COMMAND The name of the process

reset
Occasionally, you may find that your terminal gets
corrupted. This is quite rare these days, but it can
still happen, and you get nothing but garbage on
screen. Just type reset, even if you can't see what
you are typing, and things should soon be back to
normal.

rm
This is one of the most basic file handling
commands, and potentially one of the most
destructive. It removes files, or rather it removes the
directory entry for the file, although the data is still
on the disk until over­written. You do not need write
permissions on the file to remove it, only write
permissions on the directory that contains it. When
used with the ­r option, it will remove files recursively
from directories, which is obviously dangerous, and
for that reason, most systems have an alias that
reads alias rm='rm ­i'. This makes the command
interactively prompt for a y or n before removing the
file.

script textfile
After typing this command, everything you do at the
terminal is copied to the file 'textfile' (or whatever you
called it).
This can be helpful if you need to show somebody
how to do something at the terminal, and it has the
added advantage that once you have it right, you
can edit out all your failed attempts.

stat
Prints out information about a file gathered from the
inode that holds the files metadata.

If you ever see the error message "can't stat file
************", it usually means that the file doesn't
exist (in the directory that you instructed the
command to look for it).

tac
Where cat prints out files first line to last line, tac
prints last line to first line, reversing the order. This
behavior can be modified by changing the separator
using option ­s. The default is a newline.
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tail
Tail is useful for displaying just the last few lines of a
file. By default, 10 lines are shown, but this can be
changed by passing the number of lines required as
an option e.g. tail ­15 logfile. See also head.

tee
Use this when you want the output from a command
to go to more than one place. You might want to
view the output of the command and to also save it
to a file:
cat /etc/fstab | tee ~/myfstab
This would display the file on screen, and also write
it to a file in my home directory.
Multiple destinations may be specified. The ­a option
appends the information to a file.

uname
You can display information about the machine and
its operating system, and this information can help
when troubleshooting.

The options are:
­a all information­m system hardware­n network host name­r kernel release­s operating system­p processor type­v kernel build info.

uniq
This command finds duplicate lines in a sorted file.
The lines must be next to one another, so the file
must first be sorted.
This is usually done on the fly with the sort
command.
Suppose that you had a file containing a list of
objects, and you believed that some of them may be
duplicated. Jane has a list of American states in no
particular order.
To show only those states that are duplicated, you
can use the ­d option.

To find out how many times each duplicated entry
appears, use the ­c to add a count. This would be

useful to make an inventory if the list was a stock
list.

To get the list that Jane wants, a sorted list with no
duplicated entries, the output of the command with
no options is sent to a new file.

The file size shows that the duplicated entries have
been removed.

wc
Use this command to count the number of
characters, words or lines in a file, with the
corresponding options ­c, ­w or ­l.

Of course, the input doesn't need to be a file. You
can pipe the output from another command to count
the number of results returned.
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whatis
Have you wondered, "what does that command do?"
This command may help by printing a one line
description from the man pages.
If nothing is found, then it politely replies "Nothing
appropriate."

whereis
This command will search for, and output, the full
path to the executable file, the man pages and the
source of any command.
The ­b, ­m and ­s options will limit the search to the
binary (executable), manual or source files only.

who
Although originally intended for multi­user systems
to find out who was logged on, this command has a
few useful options on a stand­alone system.
who ­b will tell you the last time the system was
booted
who ­d gives a list of dead processes
who ­r displays the current run level
Adding ­H will add a row of column headings to the
output.

You may also type who am i, which seems pretty
pointless, and there is also a stand alone command
called whoami. These return different results
depending upon your situation. Consider this:

Here, both commands return your usual user name
when you are operating as a normal user. However,
when you switch users with the su command, the
who am i command tells you who you really are
logged in as, and the whoami command tells you
who you are being seen as when issuing
commands.
This is particularly useful in scripts to check the user
integrity before issuing a potentially disastrous
command.

xargs
This is one that you really should have a good idea
about. It allows you to pass as many arguments as
you like to a command.

This can be difficult on a command line, but this
command is a boon in scripts, and that is where it is
often found.
With the xargs command, you can re­direct the
output from a command as a series of arguments to
another command.
find . ­iname "c*.sh" | xargs lpr
This will print out the contents of all the files in the
current directory that begin with c and end with .sh
(shell scripts?) to your printer ­ even if there are
thousands of them that couldn't possibly be listed on
the command line.
In a shell script, you will rarely know how many
results you will receive from a command, but this
command will pass them all to your destination
command sequence, and you may filter the stream
to pass over only the results that you are interested
in.

And the rest?
Well yes, there are many, many more commands at
your disposal when you are using the command line
interface to a Linux or Unix system. The few that I
have described above are the ones that I find most
useful, and all of them have a great deal more
functionality than I have described here.
Linux has almost all of the commands readily
available to do whatever you wish, and you can
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create your own, personally tailored commands to
perform the functions that you cannot readily find
available.
You can then offer them to others who may find
them useful. This is the way that Linux/Unix
developed, and sharing and developing is the basis
of the open source community, which has provided
us with a superb, free operating system.

Screenshot ShowcaseScreenshot Showcase

It's easier than E=mc2
It's elemental

It's light years ahead
It's a wise choice

It's Radically Simple
It's ... Posted by ef2000, July 28, 2010, running e17
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OGG MP3

Linux Time and the bootin' is easy
Open Source and the safety is high

Oh Texstar is rich and PCLOS good lookin’
So hush little users don't you cry

One of these mornings you're gonna wake updatin'
Look to the panel see that auto notify

But 'till that morning there ain’t a nothin' to alarm you
Your friends in the forum gonna be standin' by

ms_meme's Nook: Linux Timems_meme's Nook: Linux Time

http://www.pclosmag.com/html/Issues/201008/files/linuxtime.ogg
http://www.pclosmag.com/html/Issues/201008/files/linuxtime.mp3
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by Paul Arnote (parnote)

Many users of KDE and Gnome are accustomed to
the rich context menus of the Dolphin, Konqueror,
and Nautilus file managers. Xfce users aren't left out
in the cold, however. Customizing the context (right
click) menu of Thunar is actually quite easy, and can
be nearly as "full featured" as those of the file
managers for the bigger desktop environments.

Step One

Once you have Thunar open, select "Configure
custom actions..." from the Edit menu.

You will then see the dialog box pictured above.
Click on the green "+" button to add a new custom
action.

Step Two
Once you've selected to add a custom action, you
will then see the "Create Action" dialog box
displayed on your screen. Under the "Basic" tab,
there are four things for you to select or fill in. The
first, the "Name" field, is the name that will be
displayed on the context menu. The "Description"
field holds the description of the context menu item,
and is displayed if you hover your mouse over that
menu item. The third field, "Command," is the
command to execute when the menu action is
selected. We'll talk more in­depth about the
command field a bit later on. The last selection you
have to make is whether or not to display an icon
next to the context menu item. If you don't want an

icon displayed, simply do nothing. If you want an
icon displayed, click on the "No Icon" button, and
select an icon from the icon selection window that
opens up.
Notice at the bottom half of the window there are
directions about command parameters. For the sake
of clarity, here are the choices:
%f The path to the first selectedfile%F The paths to all selected files%d Directory containing the filethat is passed in %f

Xfce 4.6.2: Customize Thunar's Context MenuXfce 4.6.2: Customize Thunar's Context Menu
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%D Directories containing the filesthat are passed in %F%n The first selected filename(without path)%N The selected filenames (withoutpaths)

Under the second tab, "Appearance Conditions," you
can select under which conditions the context menu
is displayed. You can make the context menu
displayed for all files and file types, or you can
narrow it down to very specific conditions. The
choice is yours. Be careful adding too many items

that are displayed for all files and file types, as the
Thunar context menu will become quite large. For
me, I've found it much better to somewhat limit the
conditions under which the new context menu item
is displayed. We'll talk more in­depth about this a
little later.

Step Three
Let's take this opportunity to actually add in a useful
context menu item. For our exercise, we're going to
add a context menu item that converts a JPG file
into a PNG file, using the command line tools of
ImageMagick.

Under the "Name" field of the "Basic" tab in the
"Create Action" dialog box, we're going to call our
new menu item "Convert JPG ­­» PNG." The
"Description" field contains a more general
description that is displayed when the user hovers
their mouse over the top of the menu item. Here,
we've entered the description as "Convert JPG file to
PNG file."

We've also entered the action to take when the
menu item is selected, under the "Command" field.
Here, we've entered the following:
convert %F `basename %F .jpg`.png
Please note that the command uses backticks, not
the single quote character. The command converts
multiple files (%F), using the "convert" command
from ImageMagick, then uses the "basename"
command to strip the .jpg file extension, and then
add the .png file extension to the converted file.
I've elected to display an icon in the context menu,
so I clicked on the "No Icon" button and chose an
icon to display next to the context menu entry.

Under the "Appearance Conditions" tab, I've elected
to display the context menu only when jpg files are
highlighted, and only for image type of files. This
way, if I highlight a .txt or .tar.gz file, the context
menu isn't littering up Thunar's context menu. This is
especially useful, since the command would have no
effect upon those types of files anyway.

Xfce 4.6.2: Customize Thunar's Context Menu
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Here is what it looks like in the "Configure Custom
Action" dialog box after you've finished defining the
custom action:

You can also edit a custom action by clicking on the
icon with the pencil on it. Similarly, you can remove a
custom action menu item by clicking on the red "X"
button. The blue up and down buttons allow you to
move the custom action menu item up or down in
the list of menu items.

Advanced Topics
We can't just let the discussion stop here. There are
other things to consider, when it comes to the
"Command" field under the "Basic" tab of the
"Create Action" dialog box, and when it comes to
specifying the "File Pattern" field under the
"Appearance Conditions" tab.

First, let me preface the discussion that follows with
this: this is not going to be a full discussion or tutorial
of the ImageMagick convert command. Entire books
have been written on how to use ImageMagick and
all of its tools. Just covering the convert command
alone would take much more time and space than
we have here. If you haven't yet explored and
unleashed the power of ImageMagick, you may want
to check out the ImageMagick command line tools
page, or the ImageMagick Examples page.
ImageMagick provides some very powerful tools for
dealing with graphic files, and there is literally
nothing that equals or comes close for dealing with
graphic files from the command line.
We can keep the command very, very simple. The
command
convert %F %F.png
will process the conversion, and simply append the
.png file extension on the end of the full file name.
So, if your input file is tiddlywinks.jpg, the output file
will be named tiddlywinks.jpg.png. This isn't too
much of a problem when you're dealing with only a
few images, since you can easily manually rename
the files. It becomes troublesome when you are
converting a large number of images, and will
require an additional step (or two) to rename the
files.
The "File Pattern" field in the "Appearance
Conditions" tab is case sensitive. So, if you want the
context menu to appear for all JPG files, regardless
of the case of the letters, you could place the
following in the "File Pattern" field:

*.jpg;*.JPG;*.jpeg;*.JPEG
This will cause the context menu to display for any
of the four combinations of file extensions, and only
files ending with those file extensions. But there is a
small problem: files with extensions not exactly
matching the exact spelling and case of the file
extension specified in the "Command" field of the
"Basic" tab will simply have the .png file extension
tacked onto the end of the existing file name and
extension, as in the previous example using the
very, very simple command.
If you want more precise control, where the file
extension is properly stripped off and the .png file
extension is appended, you could create a custom
action for each of the four file extensions above: jpg,
JPG, jpeg and JPEG. You would also have to alter
the "basename" command to strip the respective file
extension, in the "Command" field on the "Basic"
tab.
Here are some other image manipulation
commands, courtesy of ImageMagick, that you may
be interested in turning into custom actions for
Thunar's context menu. Use caution with the
following commands, because they will
overwrite the original image file, and your
original image WILL be LOST! These commands
are best used on a COPY of the original file.
To rotate an image (or group of images) 90 degrees:convert %F ­rotate 90 %F
To alter the compression level of an image to 50%
quality: convert %F ­quality 50% %F

Xfce 4.6.2: Customize Thunar's Context Menu
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To resize an image to a width of 450 pixels:convert %F ­resize 450 %F
To resize a JPG image to a width of 450 pixels,
convert it to PNG, strip the existing file extension,
and rename the file to let the user know that the file
has been resized to 450 pixels wide:
convert %F ­resize 450 `basename %F.jpg`­resize450.png
(By the way, don't worry about having to specify both
the width and the height of an image; ImageMagick
will automatically preserve the aspect ratio if you
specify only the width).

Conclusion
Of course, you can do more than just deal with
image files from Thunar's context menu. You can
specify commands that run scripts, compress files,
play multimedia files, etc. You can do pretty much
whatever you can imagine from Thunar's context
menu, provided you can supply the proper command
or commands. I'll leave you to explore the endless
possibilities of custom actions you can set up.
If you are interested, you can read more about
setting up custom actions for Thunar's context
menu, at Thunar's web site. Let your imagination run
wild.

Screenshot ShowcaseScreenshot Showcase

Posted by coffeetime, July 05, 2010, running OpenBox
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by Meemaw
We have looked at OpenOffice Writer, covering
some of the basics of the program and what was
included. This month we'll look at some of the basics
of OpenOffice Calc, which is the spreadsheet
program in the OpenOffice suite. When you open it,
you will have an empty spreadsheet grid for
whatever data you want to organize. This will be a
very basic review, because there are many things
that Calc can do that I've never used.

The toolbars are almost identical to those found in
OO Writer: however, some of the individual buttons
are different. The main toolbar has all the standard
features, like cut & paste, save, open, new , print,
etc. The formatting toolbar is different in places.
Instead of the numbering and bullet buttons that are
used in Writer, you will have buttons for changing
cell contents ­ you can highlight cells and format
them as currency, add or subtract a decimal place
from your numbers or put borders around specific
cells. Instead of editing text, you can choose a filler
color for the cells you have highlighted. Also, two
sorting buttons are in the top row to sort your data
alphabetically, or reverse. You can also display a
graph to go with your data if appropriate.
Spreadsheets can be used for quite a few projects!
In addition to keeping track of monetary amounts for
each month of the year (only one use), you can build
forms (like invoices or statements), make address

lists (you can do this in a database program, but if
you only need name, address, city & state, a
spreadsheet is just as easy, if not easier.) I use
spreadsheets to do address labels quite often.

In my job, I have to submit a list of upcoming bills to
my bosses, so they know where the money is being
spent each month. I use a spreadsheet because you
can set it to add a column of figures. That way, they
know the total, and I don't have to run the adding
machine three times to make sure I didn't add
wrong!!! In the example I did a quick home budget
list that is similar.

In the next shot I highlighted the numbers in the
money column, starting with the cell where the sum
should be displayed and dragging my mouse up.
Then up above the spreadsheet (but below the
toolbars) in the formula bar, click on the symbol (Σ).
Your sum should appear in the bottom cell.

The formula bar has the characters that are in the
cell you have selected. If you have numbers or text
in the cell, the formula bar will show what is there. If
you are doing a spreadsheet with mathematical
calculations in it (like the number sum above), it will
show the formula for getting that answer. In the
example above, the formula is =SUM(E4:E11) which
means that the numbers in cells E4 through E11 will
be added together and the answer displayed in E12
(which is the cell where the formula is located.) In a
budget, for example, we could add our income and
bills separately, then put a formula in a third cell
which would stand for the difference between
incoming and outgoing cash to let us know our
month­end balance. The Insert > Function menu has
a list of formulas you can use. You can also get the
same list from the fn button to the left of the formula
bar.

OpenOffice 3.2: CalcOpenOffice 3.2: Calc
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You can make your document a little prettier, if you
wish, by putting colored backgrounds in some of the
cells. I highlighted 5 cells, then clicked on the
background color button on the toolbar, and chose a
light blue. I also made the row height smaller, so that
my cells would look like a colored border. Click on
Format > Rows > Row Height (or Format > Column
> Column Width) to change the size of the row or
column ­ or if your hands are very steady, you can
'grab' the row border at the bottom of the box with
the row number in it, or the column border at the
right of the letter and drag it to suit you. You can get
close, but if you want several of them the same
width or height, you're more accurate highlighting
the ones you want to change and using the format
menu.

You can go through and
color cells and put your
information in until you
have it the way you want
it. You can always click
the 'Print Preview' button
to see what it looks like
(and with a little more
than 15 minutes work,
I'm sure you can make
one that's awesome!)

Another thing you can do that might make your
spreadsheet look a little better is to merge cells.
Sometimes I'm doing a sheet that needs a title, and I
want the title centered. If the title is in the
spreadsheet itself, I highlight the number of cells that
equal the width of the sheet, then click the 'Merge
Cells' button.

If you haven't clicked on the 'Center Text'
button, do that as well. In some of the
spreadsheets I do, the columns are different
widths, so merging the cells and centering
the text gets it centered the way I want it.

You can format the cells to add lines in specific
places (like underneath the headings in each section
or at the bottom of a column of numbers being
added) or have your numbers show in a particular
format. Just highlight the desired cells and click
Format > Cells and you'll get a formatting box; use
the arrangement section at left to designate the
locations of the lines and the style box to make the
line the correct thickness. I actually changed mine to
2.50 pt.

OpenOffice 3.2: Calc



36

If you only have a few places you want the borders
to go, you can highlight the cells and use the
Borders button on the toolbar (in my example, the
borders button is in the bottom row of tools to the left
of the background color button.) You will get a drop­
down with several choices.
In the same formatting box, the tabs across the top
include 'Number'; this is where you can format
numbers to look the way you want them. In a
financial worksheet, I like them all to have two
decimal points and a comma for the thousands
place. I format them as numbers rather than
currency. Why? Because when you format them as
currency, each number includes the currency label
you choose, and I only want my dollar signs at the
top and bottom of each series, not on every amount.
Therefore, I use an extra column to the left of my
numbers so I can put the dollar signs where I want
them.
Now, if you've gone to print your spreadsheet, and it
says 'Sheet 1' at the top.... and you don't know who
put it there.... you should go to Format > Page and
choose the 'Header' tab. There is a button that says
'Edit' ­ click that one and you will see a chart
showing items displayed in the header of your
document. The center section has 'Sheet 1'. You
can delete that text, or you can cancel out of that, go
back to the header tab and uncheck the 'Header On'
box. Conveniently, there's more than one way to do
something.
Just like in Writer, OpenOffice.org has loads of
templates for use in Calc. You can find templates for
graph paper, budget sheets, amortization schedules,
grocery lists and even a Sudoku game!
http://extensions.services.openoffice.org/project/ .

There are exterior sites that have templates as well.
If you are looking for a specific template, you can go
to one of these sites:
http://www.vertex42.com/
http://www.spreadsheet123.com/
http://www.sysmod.com/free­software.htm
I've found loan payment schedules, budget sheets,
the Sudoku game and even graph paper!!! Many of
them say Excel, but we know we can open them
anyway.
Calc will do much more than what is covered here!!!
I hope you'll take some time to explore. Next time
we'll look at Impress.

OpenOffice 3.2: Calc
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Would you like to help with the PCLinuxOS
Magazine? Opportunities abound. So get
involved!
You can write articles, help edit articles, serve
as a "technical advisor" to insure articles are
correct, create artwork, or help with the
magazine's layout.
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by Peter Benecz (sixthwheel)
I've been using some form of Linux distro for the
past few months now with a few problems, and just
stumbled upon PCLinuxOS by accident. A happy
accident, if I say so myself.
The problems I had were really minor, compared to
the problems with Windows, which I've been using
since Win95. So I was really happy to discover Linux
in general. However, I could not find one distro that
worked with everything that I needed. The one distro
that came close was Ubuntu 9.10 (Karmic). Then I
upgraded to 10.04 (Lucid Lynx), and I couldn't get
my Skype webcam working, after much searching.
Then I tried Mint, which was great. Except that after
coming out of hibernation, I would have to reboot

because the system froze. While searching for a
solution, I came upon a thread in the Mint forums.
Someone mentioned that a rolling release OS had

less bugs and problems. So I did a search for Linux
rolling releases. I read through most of the reviews,
and PCLinuxOS caught my eye.
It looked like everything a new Linux user could
want. I downloaded the Gnome version, (that's what
I'm used to), and played with the live CD for a while.
Then, I installed it next to Mint, and I screwed up the
partitioning and deleted Mint. (Yes I should have
used Gparted to prep it for a dual boot install). No
biggie, since I have everything important backed up
to an external drive. (I learned to do that a long time
ago, re installing Windows a million and one times).
So far I'm really happy with it, and would like to
thank the developers for a great job. I also
downloaded the KDE 4 package, and have been
playing with that for a while. Everything looks and
works very well, and I think my search for a distro
that works for me is finally over. I really like the idea
of a rolling distro, instead of a new release every 6
months, whether it's buggy or not. (I never really
understood that philosophy to tell you the truth).
However I digress, since this is not a post to bash
other distro's or Windows.
I'm just real happy with it, and hope to be using it for
a long time to come. Thank you.

Visit Us On IRCVisit Us On IRC
• Launch your favorite IRC Chat Client
software (xchat, pidgin, kopete, etc.)

• Go to freenode.net

• Type "/join #pclinuxos­mag"
(without the quotes)

Your Community Projects Forum
Visit.

Contribute.
Build.

The PCLinuxOS
Wiki

It Belongs To YOU!

Testimonial: PCLinuxOS: an Accidental DiscoveryTestimonial: PCLinuxOS: an Accidental Discovery

http://www.pclinuxonline.com
http://www.pclinuxos.com/wiki/index.php/Main_Page
http://www.oneclicklinux.com
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by Darrel Johnston (djohnston)
Before beginning a summary of Haiku's
applications, I'd be remiss if I didn't say a
little more about the BeFS (BeOS
filesystem), not to be confused with BFS, the
UNIXWare filesystem. Although written in the
late 1990s, it has some advanced
capabilities. It is a journaling, multi­threaded,
64­bit filesystem, optimized for streaming file
access, and containing database­like
extended file attributes. Using it, you can
create disk partitions in excess of 8
exabytes, (that's 8,000 terabytes), and
create files that are larger than 30 gigabytes
in size. One of BeFS's most important and
widely touted features is its support for
extended attributes. If you want to associate
information with MP3 files using a
conventional file system, you might have to
create your own database to support
searching, creating, updating, or deleting
these attributes as your music collection grows and
changes. With BeFS, the attributes can be added to
the file system itself. This means that a program for
editing or playing MP3s does not need to create or
maintain a database, because the file system will
handle these functions for you. BeFS supports
associating attributes within a file, and attributes can
be searched and sorted by the file system, as an
extension of any application. For a much more
detailed analysis, see this article, written by Andrew
Hudson. http://arstechnica.com/open­
source/news/2010/06/the­beos­filesystem.ars
A BeFS partition can be created with PCLinuxOS's
own partitioning tool, and with GPartEd, as well as
other disk partitioning programs.

There are a few general purpose and some special
purpose applications included in the Haiku
R1Alpha2 installation. They are:
Name Description
­­­­­­­ ­­­­­­­­­­­­­
Activity Monitor CPU & memory usage

viewer
BePDF Views PDF files
CDPlayer Plays audio CDs
Character Map Font viewer
Clockwerk Multi­track audio/video

compositing & animation
CodyCam Webcam monitor and

recorder
DeskCalc A basic calculator

Devices Device viewer
DiskProbe Disk and file hex editor
DiskUsage Shows your disk usage

graphically
DriveSetup Disk partitioner and

formatter
Expander Zip file manager
Icon­O­Matic Graphic to icon converter
Installer Install HaikuOS
Magnify Screen magnifier
Mail POP/IMAP mail client
MediaConverter Audio/video file converter
MediaPlayer Audio/video file player
MidiPlayer Plays MIDI files (doesn’t

currently work)
PackageInstaller Installs .pkg files (runs from

Terminal)
Pe The favorite code editor of

Haiku developers
People Contact manager
Poor Man Simple web server
Screenshot Screen capture utility
SoundRecorder Records audio
StyledEdit Basic word processor
Terminal Command line window with

BASH
TV Interface to TV viewing

cards
Vision IRC client
WebPositive Web browser
WonderBrush Image editor
Most daily tasks, such as web browsing, text editing,
and playing of audio and video files can be done
with the included programs. Not all multimedia
formats can be played, however. For example, the
included web browser does not play flash videos.
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The developers are
aware of the shortage
of applications and
the limited abilities of
some of the
applications. For this
reason, they've been
scouring the web for
older BeOS
applications, and
asking for new
submissions.

The web browser has the
following sites bookmarked
under the Software folder:
http://ports.haiku­files.org
http://haikuware.com **
http://dev.osdrawer.net
http://zeta­games.com

Alternate OS: Haiku, Part 2
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Haikuware was chosen as the central
repository because it has 2640+
applications to download. It also has a
rating system, user forums, a built in
email system, and a way to leave
comments for each application. To install
an application on Haiku:
1) Open your WebPositive web browser
from the Applications menu
2) Go to Haikuware.com
3) Download the application you want by
clicking on Download
4) Launch the Expander by clicking on
the Open button after download
completes
5) Change the install path from
/boot/home/Desktop to
/boot/apps
6) Click Expand
To run your new
application:
1) Right click on your file
system icon (upper left
corner of desktop)
2) Select the apps folder,
then your application’s
folder.
Some applications have
an additional setup script
or setup instructions.
Look for a README file.
If the application is
downloaded as a .pkg
file, open Terminal from

the Applications menu and run PackageInstaller
from the command line. Use the PackageInstaller to
complete the installation. Some applications or
libraries can be installed using the
installoptionalpackage utility. Open Terminal and
type installoptionalpackage –l to list packages or
libraries that are available to install or update.
The Be operating system was touted as a highly
capable and efficient multimedia system. Haiku is
beginning to live up to that promise. It has a vastly
improved networking structure. And the BeFS has at
least one capability, metadata storage in the
filesystem, that others cannot yet match. The only
drawback, if it can be considered as such, is that the
system only allows for one user. Whether this will
ever be addressed is unknown.

Alternate OS: Haiku, Part 2
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by Daniel Meiß­Wilhelm (Leiche)
For a few years, under Windows, I had created
video CDs and DVDs with TMPGEnc, or HC­
Encoder. Both are very popular video transcoding
programs. HC­Encoder needed avisynth, a frame
server, but that is another story. Instead, using the
matrix from molevcd produces very good quality.
Under PCLinuxOS, I installed avidemux, then
Handbrake. Handbrake does the job very quickly, it's
easy to handle, and it produces good quality output.
But the bad thing is that the developers of
Handbrake removed the avi container, and my store­
bought media player now only plays avi, mpeg or
wmv files. What's new?
I searched and searched, added some apps from
the repositories of PCLinuxOS, but nothing else is

as fast as encoding with Handbrake. DivX Converter
is a frontend for mencoder, but my test file took 12
hours to process, and the quality was not what I
expected.
Mencoder, as a command line program, is not quite
so handy for me. The output is perfect, no doubt
about it, but i need a GUI or frontend for mencoder. I
finally found jMencode, a frontend for mencoder.
To open a file, click on Single File Input, and the
button with the ellipsis, to the right of the "Path" text
input box. Then open the file browser and go to the
folder where your video is.

To open the video file click on Öffnen (Open) and
jMencode analyzes the file. You can see the details
in the main window.

When we want to create an avi file, we can skip the
Audio window because mp3 output has already
been selected.

Next go to the Video window and set the codec and
other things. Usually, 1­pass encoding works well for
me, and the quality for my old TV is perfect. The
container is avi, and for CC, I chose XVID. If I forget
that, my media store player won't play my video. I
set the input DAR (aspect ratio) on 16:9, and other
options I left at their default settings.
The next window is Rescale & Crop.

Video Encoding: Step-by-StepVideo Encoding: Step-by-Step
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With the slide control under the picture, you can
search a perfect picture for cropping or rescaling.
Click on
and set Keep Anamorphic, when you want 16:9. I
didn't click it in the following screen shot, since it
was already preselected for me.

Now click on the hook button, and you see the
output.

After rescaling my video to 432x224, the picture
seems correct to me.
All settings are complete. Now we should click on
the encode button, but this button doesn't work at
this time. I have contacted the developers and hope
it will corrected in a new version. You can copy the
generated command from the main window with
"ctrl+a“ + "ctrl+c“, then paste it in a konsole. The
generated mencoder command is as follows:
mencoder ­oac mp3lame ­lameopts abr:br=128 ­sws 2
­ovc lavc ­lavcopts
vcodec=mpeg4:vbitrate=700:vhq:vpass=1 ­ffourcc
XVID ­vf scale=432:224
/home/daniel/Dokumente/Videos/myvideo.mpg ­o
"/home/daniel/Dokumente/Videos/myvideo.mpg.avi"

and press Enter.

You can play the output file with any player, if you
want.

Mencoder does what I need, and works perfectly for
me. The encode button in jMencode doesn't work,
but hey, working in konsole is really fast.
Good luck with jMencode.

Video Encoding: Step­by­Step
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Screenshot ShowcaseScreenshot Showcase
1. All the contents of the NEW PCLinuxOS Magazine are only

for general information and/or use. Such contents do not
constitute advice and should not be relied upon in making (or
refraining from making) any decision. Any specific advice or
replies to queries in any part of the magazine is/are the
person opinion of such experts/consultants/persons and are
not subscribed to by the NEW PCLinuxOS Magazine.

2. The information in the NEW PCLinuxOS Magazine is
provided on an "AS IS" basis, and all warranties, expressed
or implied of any kind, regarding any matter pertaining to any
information, advice or replies are disclaimed and excluded.

3. The NEW PCLinuxOS Magazine and its associates shall not
be liable, at any time, for damages (including, but not limited
to, without limitation, damages of any kind) arising in contract,
rot or otherwise, from the use of or inability to use the
magazine, or any of its contents, or from any action taken (or
refrained from being taken) as a result of using the magazine
or any such contents or for any failure of performance, error,
omission, interruption, deletion, defect, delay in operation or
transmission, computer virus, communications line failure,
theft or destruction or unauthorized access to, alteration of, or
use of information contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom the NEW
PCLinuxOS Magazine has no control or connection, business
or otherwise. These sites are external to the NEW
PCLinuxOS Magazine and by visiting these, you are doing so
of your own accord and assume all responsibility and liability
for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The NEW PCLinuxOS Magazine accepts no responsibility for
the content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

Posted by exploder, July 28, 2010, running KDE4
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by Gary L. Ratliff, Sr. (eronstuc)

Introduction to Modula 2

Modual2 was invented by Niklaus Wirth, who was
the inventor of the language Pascal. In addition to
this language, he also invented Oberon2, which is
an object orientated version of Modula2. Once
Pascal was introduced to the computing world, it
was readily adapted as a teaching language. Soon,
there were many variations on the language which
Wirth took to indicate short comings in the language.
This prompted him to develop a language named
Modula in 1975, and from this,
to later develop Modula 2 in
1979.

The most distinguishing feature
of Modula 2 is that programs
may be developed and
compiled in separate modules.
The language was introduced
with a set of features of the
language, and also a set of
modules which were not
regarded as parts of the
language, but which were
regarded as desirable by Wirth
to use the language.

As with Pascal, soon various implementations wered
eveloping their own sets of these modules. This
action led to an effort to standardize the language
and make certain modules have required names and

items in the procedures supported by the module.
This results in a programming style which allows
the features with either the Wirth named modules
or the names as required by the ISO standard.

Learning the Modula 2 Language

We now need to locate a tutorial which will
introduce us to the Modula 2 language. The
easiest method is to enter the words Modula 2
into the Google search engine. From the items
shown, select the item Modula Home, and you will
receive the following page:

Here we find
that a tutorial
for novice users
is most likely to
be one which
we may use to
learn the
features of the
language. As
this tutorial also
assumes that
the reader is
new to
computers, it
serves as an
introduction to
the entire field.

To reach it, just click of the line in the above page
named “Modula­2 Tutorial,” and this will bring up the
following page:

First, the best approach would be to just start with
the preface and introduction. This will let you know
that Part I of the tutorial is required reading before
you begin to peruse either Part II or Part III. On
reading this tutorial, you learn that some of the most
important information only has the text: “Under
development.” That first appears in the section
named Input/Output.

Second, it is for this reason that I suggest that you
also use the tutorial by Rick Sutcliffe. This tutorial is
very complete. It also offers many complete
programming examples. To find this tutorial, you will
click the LINKS item in the above page. This will
produce the next page:

Computer Languages A to Z: Modula2Computer Languages A to Z: Modula2
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Once on this page, you will reach the tutorial by
clicking the item: “Modula 2: Abstractions for Data
and Programming Structure.” This will produce the
following page:

This is a text book in 19 chapters. Each of the
chapters will have several sections, which will be
navigated by clicking the link to each section which
will be found in the upper right portion of the page.

Note that each chapter will have a quiz, and that
answers to the material are provided. With these two
tutorials, one should have little problems in learning
to use the Modula 2 language.

A Compiler for Modula 2
It is in the selection of a compiler that one
experiences some problems. At first, the GNU
Modula 2 reported that it was not finished. However,
recent checks have reported that the system was
now complete. Yet, following the directions for
installing the system both on the PCLinuxOS
partition, and on one I have for Debian Lenny 5.0,
yielded unsuccessful results. Here are the
instructions given for obtaining and installing the
system:

“For example you should be able to download the
latest version of GNU Modula­2 and GCC using
these commands:"

$ wgethttp://flopssie.comp.glam.ac.uk/download/c/gcc­4.1.2+gm2.\ cvs­latest.tar.gz
$ tar zxf gcc­4.1.2+gm2­cvs­latest.tar.gz

This step is successful and will get the latest version
of these two files. Next, it becomes necessary to
build the system. So the text continues:
“On a GNU/Linux system, you should also be able to
build it using these commands. The following
commands assume your shell is '/bin/bash'. To build
GNU Modula­2 type:”
$ mkdir ­p $HOME/opt
$ mkdir ­p build­4.1.2
$ cd build­4.1.2
$../gcc­4.1.2+gm2­cvs­latest/configure–­enable­languages=c,c++,gm2 \­­disable­multilib –enable­checking=all –prefix=$HOME/opt
$ make “SHELL=/bin/bash”

“To install GNU Modula­2, after a successful build,
type:”
$ make “SHELL=/bin/bash” install
$ cd ..

“Now you should be able to perform:”
$ export PATH=$HOME/opt/bin:$PATH
$ cd gcc­4.1.2/gcc/gm2/examples/hello
$ make

Computer Languages A to Z: Modula2
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“which will create an 'a.out' for the infamous hello
world example.”
However, when attempting the ' make
“SHELL=/bin/bash” ' the system reports “/lib/cpp
fails sanity check.” By tracing the links for cpp in its
trail beginning with “/lib/cpp,” we learned that this
refers to the gcc version 4.4, and not the version
4.1.2 as should be used by this system. Now, as the
article on Fortran just appeared and this article
should not reach print until August 2010, perhaps by
this time an easy to install version of the GNU
Modula­2 system will be in the repository. The
complete system has just been finished and they are
setting up deb packages for Lenny with, I would
assume, others to follow.

Another system is the XDS, which provides
translation from a mod file into ansi standard C.
Simply download either the native language packet
or the C packet and install it. Then, one sets the path
to include its location. The command xm hello.mod
yields a file hello.c. Yet when attempting to compile
this with gcc, it reports that the inout.h, and several
other files, can't be located. The xds package does
double duty in being able to compile Oberon2, which
is the OO version of Modula­2, also developed by
Niklaus Wirth.

Computer Languages A to Z: Modula2
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Answers to Mark Szorady's Double Take:
(1) Helmet smaller; (2) Shirt stripes different;
(3) Hair shorter in back; (4) Satellite dish tilted down;
(5) Laptop screen smaller; (6) “Totally” changed
to “entirely”; (7) Mouth closed Posted by T6, July 26, 2010, running KDE4
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OGG MP3
In the summer time and you wanna be cool

Grab your PC head right straight for the pool
I mean your PC your

P C L O L O L O S
Let the fun begin we're gonna do it again and again

Come on and sit right down and enjoy the breeze
Boot right up just as fast as you please

On your PC your

P C L O L O L O S
Let the fun begin we're gonna do it again and again

Take a sip or two of your favorite brew
Go on line you'll know just what to do

With your PC your

P C L O L O L O S
Let the fun begin we're gonna do it again and again

Invite all your friends they'll have a blast
Your PC really was meant to last

Love your PC your

P C L O L O L O S
Let the fun begin we're gonna do it again and again

ms_meme's Nook: PCLOLOLOSms_meme's Nook: PCLOLOLOS

http://www.pclosmag.com/html/Issues/201008/files/pclololosE.ogg
http://www.pclosmag.com/html/Issues/201008/files/pclololosE.mp3
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Chuck Chunder: What's your fav time waster
and why? I happen to like the hydrogen drum
machine:
* Annoys the other people in the house.
* No expensive drum kit.
* No space taken up when not in use.
* Wastes time wonderfully.
longtom: Thanks for pointing me to that program!
My son will love it ­ and I get his earphones ready.
Otherwise I just purchased Settlers 6 on a serious
special ­ love this kind of games...
Chuck Chunder: You can use the keyboard too.
Start by using the keys on the bottom row (z­m), also
s,t,q,w
grnich: Online flash game. Google search "Kitten
Cannon" It never gets old. Have fun.
MBGguy: freedoom­iwad ­ in the repositories.
Weirdwolf: +1 Only play it 3­4 times a year though.
jaydot: freecell, mahjongg, knetwalk. hours gone
unnoticed.
Rudge: I actually play the drums so I can see
myself waisting a bunch of time with this. Thanks.
It's good old Frozen Bubble for me. I do tggle the
music off after about an hour, oh and I run it with the
­notime option so I can set up my shots verrrry
carefully.

TuxTorch: I'm a drummer too! I'll check this out.
LMMS is good for electronic music as well replaces
Fruity Loops in Windows, for games I've been
playing Ice Breaker (icebreaker in repositories),
Super Tux, Gnometris, Hedgewars, etc.
Rudge: Nice, so far it seems "crashy" but I can
work around that. It took me a bit to figure out how to
adjust the sustain of a given instrument but this is
great! Thanks, I didn't know about it.
TuxTorch: No problem, fruity loops was one
program I was missing when I first came to Linux
then I found LMMS. It does take some getting used
to...
Xyus: When I kill time, I usually use something
very Sharp. Like Mono. But seriously, I haven't used
PCLOS long enough to have a favorite time killer,
but I've played a lot of Battle for Wesnoth over the
last few days. And I carried over my use of "messing
with Psycle" (I.e. Making random, highly annoying,
musical "noises") as a pass­time from Windows. I
use the windows version under WINE, as it seems
the Linux version hasn't been worked on for a while.
I've got the source from the SVN repo, though, and
I'm going to play with that and see what I can get.
parnote: Hmmm ... when I get bored, I usually just
write another magazine article.
Chuck Chunder: Yes, and that boredom is certainly
well conveyed in your articles.
MBGguy: Much appreciated. Keep up the
exceptional work! PClinuxOS succeeds because of
folks like you! Not having your skills,time, and
commitment, I salute you.

sammy2fish: When I get bored...... Time to re­
install due to stuff not working like I'd like them to;
buy another LP on eBay to rip on my usb record
player; try a new a new theme and tweak the heck
out of it and discard it because I didn't like it afterall;
or see who's on the forums while sipping a
rye&coke...
Ruel24: My favorite time waster is YouTube. I
can't get enough of rare concert footage of my
favorite bands.
longtom: Time wasting and noise go together in
our house as well. My little son (12) saved hard for
a drum kit and got himself a nice Ludwig a year ago.
Since then on every off weekend I get out my old
and trusty Gibson, rig a mike on a broom stick and
chase it all through a 24 year old Roland 60W
Combo. That together with the drums gets the
neighbourhood going ­ and the rest of the family
fleeing. We looove it ­ and time flies. Wipe your
eyes and it is way to late for all those weekend
chores I was meant to do....
Xyus: Forget my previously stated hobbies, I just
discovered that Dwarf Fortress 0.31.03 works under
Wine perfectly! Now I can get back to mercilessly
slaughtering things with their own limbs!
jaydot: one i used to play a lot was gweled, but the
newer version insists on playing an annoying tune i
am unable to switch off. shame about that as i'm not
so keen on its variants.
Lee2010: When I get bored I rearrange my
desktop.... Oh and of course I play the flash game
when penguins attack.

FUN with PCLinuxOS

Forum Foibles: Fun With PCLinuxOSForum Foibles: Fun With PCLinuxOS
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By Ryan Smith (Xyus)
Every once in a while, an independent game is
released that throws the entire games industry – or,
at least a portion of the industry – into an uproar for
a short time. Within that time, many, many reviews
will be written about the game, it will win several
prominent awards, and it will become spotlighted on
all manner of “Recommended Games” lists.
These games are notable in that they did not gain
their well­deserved popularity through a large
financial backing, an all­encompassing marketing
strategy, or, in some cases, even an existing fan­
company recognition. Rather, they gained their
popularity the hard way – through great game play,
an interesting and unique concept, a whole lot of
work, and (in this case) a rather unique marketing
gimmick.
No doubt you have
heard of World of Goo,
the game developed
by 2D­Boy ­ a small
company founded by
two former EA
employees, Kyle
Gabler and Ron
Carmel ­ that became
a media sensation for
a time last year when
2D­Boy announced
that they were
celebrating World of
Goo's One Year
Anniversary with a
temporary “Pay­What­You­Want” sale. The saleattrac
ted all sorts – from those who didn't have much of

their budget dedicated to gaming, to those who
earlier pirated the game and took the opportunity to
go legit, to just general cheapskates. And while the
idea of a game that “costs what you want” gained
everyone's attention, it appears quality kept them
around ­ World of Goo's popularity seems to have
long outlasted the sale, although unfortunately not at
the same level.
Game Play
World of Goo is a physics­puzzle game in which the
goal in most levels is to direct the little goo globs into
a pipe to either be processed into various products
by the apparent corporate overlords, World of Goo
Corporation, or to help them satisfy their insatiable
need to explore. This is usually accomplished by
carefully building a tower or structure of some kind,
though quite a few levels have unique puzzles of

their
own.

The game's levels are divided into“
chapters”, each with a unique

theme and taking place in a certain season. The
chapters of World of Goo follow the game's 'story',
which is presented at the end of, (or occasionally
during), each chapter in the form of animated
sequences.
Choose a name the first time you start. The game is
played entirely by mouse. The controls are pretty
much limited to picking up and moving the goo balls
by clicking and holding the left mouse button, then
letting go of the globs in advantageous positions to
build your tower. These controls are deceptively
simple, though. Rest assured, after the first few
practice levels, this game will keep your brain "on its
toes".
Most levels of the game are completed by building a
tower or bridge to a pipe, while making sure that
enough goo balls, (an amount predetermined by the
game), survive to make it into the pipe. Since these
structures are built out of the goo balls themselves,
you should conserve as many as possible, or you

Game Zone: World of GooGame Zone: World of Goo

http://2dboy.com
http://2dboy.com/2009/10/19/birthday-sale-results/
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may find yourself in the sticky situation of not being
able to finish the level. (Although there are
measures for this – see hints section.)
While that seems simple enough, building a tower in
World of Goo is usually no small task. The game
likes to throw all manner of challenges your way,
from high velocity winds, to making all of your goo
balls particularly flammable in a level filled with lava,
to a level that continuously rotates. A few levels are
action­game like in pace.

There are many types of goo balls, and depending
on the level, one or more types of goo balls may be
present. Each has different abilities and
weaknesses, which can help or hinder your progress
in a given level. For example, the black goo balls –
the most common – have the disadvantage that they
cannot be manually disconnected from the structure
once they are attached. The green goo balls can,
which allows you to rebuild your structures at will.
Extras
There are a few not­strictly­game­play­but­still­
related elements in World of Goo.
The World of Goo Corporation HQ is a special “free­
play” chapter where all excess goo balls, (those that
were not needed to complete the level but went into
the pipe anyway), go after each level. The goal here
is to build the largest tower you can out of these
excess goos. World of Goo Corporation HQ is

“online” ­ you may see others' towers, (in the form of
clouds in the background), and the game tracks the
largest tower in the world. Bonus Fun: The theme of
the World of Goo Corporation HQ changes as you
advance in the game's “plot”.

All levels have online leader
boards that let players
compete to get the best scores
and completion time. All levels
also give players the ability to
win an OCD (Obsessive
Completion Distinction) award
for completing that level within
a certain amount of time, or
with a high amount of survival
goo balls. (Each level has its
own criteria for an OCD –
check in the menu, under
“OCD”).

Availability
World of Goo is available for Linux, Windows, and
MacOS (And Wii through WiiWare).
World of Goo is a commercial game, and may be

purchased using PayPal or a
Credit Card for 20$(US) directly
from the official site. For those of
you interested in taking this
game for a test spin, a playable
demo is available from the site.
System Requirements
Minimum Recommended:
Processor: 1 GHz IA­32
compatible processor
Memory: 512 MB RAM
Graphics: Hardware Accelerated
OpenGL drivers
Sound: ALSA or OSS compatible
sound drivers

Game Zone: World of Goo

http://2dboy.com/games.php
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International CommunityPCLinuxOS Sites

NETHERLANDS

TURKEY

DENMARK
CZECHOSLOVAKIA

ITALY

POLAND

I believe all of the libraries in World of Goo are
statically linked, so you need not worry about having
the correct libraries. Check the readme included in
the demo/full game, should you need these details.
Hints and Tips
As with last month's Osmos, you'll get the hang of
this game as you play it. But once again, I have a
few general tips.
After the first few levels, if you happen to mess up,
you can click on a time bug to go back one “turn”.
Don't forget about this! It can easily be the most
useful feature in the game.
Watch the base of your tower/bridge/balloon/etc! It
can be all too easy to concentrate on the top and
neglect the holes at the bottom. You will then get to
watch the sight of your hard work crash down
around you. Fun.
Make sure to read the signs in each of the levels.
Although sometimes they only contain flavor text,
other times they contain very useful tips.
Bored of your plain install? World of Goo has a
relatively strong modding community. Try GooFans.
Just remember – The developers of World of Goo do
not directly support these player created mods. They
may cause problems with your game. Just make
sure to back up your copy before using third­party
mods, as with any game, and you should be fine.

Conclusion/My Thoughts
This is a pretty good game. That may be saying
something coming from me. Usually this game would
be too short or linear for my tastes, but for some
reason I didn't notice much. The game play is great,
and stays fun for a while after the first play through.
I've had the game for nearly a year now, and still
play it every so often. The artwork and music style
are really unique, and they tie the game together
perfectly.
All in all, I would certainly recommend it to puzzle
lovers, no doubt about that. To all others: give the
demo a shot. I have a feeling that all but those with
the most specific tastes will enjoy this game.

Game Zone: World of Goo
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http://pclinuxos.com/?page_id=184
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by Jason Minks (J2M)
Wow! Finding this forum has provided me with my
second PCLinuxOS­related Eureka! moment in just
a few days! Google is indeed my friend! A few days
ago, I decided I was finally going to go open­source
on an OS to replace the XP that had been on a
laptop I have. I had been putting that off for a long
time, but just liked the driving concepts behind the
open­source movement. So I looked into what Linux
derivative might be best for a windows­familiar trier­
outer. When I went to the download site to get the
PCLinuxOS ISO is when I got the first pleasant
"Eureka" surprise. I was delighted to see PAGES of
available distros! I thought "this is so cool! If this
PCLinuxOS thing is any good, then this is definitely
something I want to be a part of."
So far, (only three days, admittedly, but so far so
good) PCLinuxOS has exceeded my expectations! It
sure isn't Windows, but I'm having a lot of fun

figuring the new stuff out! Like any new venture, I'm
sure eventually I'll go from just kind of laying on the
ice, as I am now, to waddling towards the shore, to
gliding through the ocean. Maybe someday I might
even understand some of what the advanced folks
here are saying!
Well, that's where I'm at, anyhow. Physically, I live in
the greater area near MS headquarters, so I'm not
quite sure if I should be afraid of their enforcement
squads or what. (Just kidding.) It's so handy that
there are so many resources on the web to
jumpstart "dead noobs" (as my son might call us ­
yes, I'm old enough to have a son who says stuff like
that ­ dern whippersnappers!) like me. It's amazing
how people work together for a purpose with this
open­source stuff. It's pretty cool.

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com
We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.

Testimonial: Hi from Washington StateTestimonial: Hi from Washington State

mailto:pclinuxos.mag@gmail.com
http://www.distrowatch.com
http://www.enkiconsulting.net
http://www.pclinuxos.com
http://groups.google.com/group/pclinuxos-beautification-2009
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Clipping Objects Together To CreateCool Graphics With Inkscape
Clipping Objects Together To CreateCool Graphics With Inkscape

by Timeth
This is a very simple tutorial for a technique anyone
can use to clip one object to another, so that the
image/text at the front defines the final shape of the
image, but it also takes on the color/design of the
image that you put behind it. It’s something you can
use on your wallpaper, for your forum profile picture
or signature, or anywhere else you’d like to use it.
Here are a few examples using country flags,
because they’re easily recognizable.

Just a few things before we get started.
1. You’ll need to install Inkscape from Synaptic for
this tutorial, if you have not already done so.
2. You can choose any image/shape and any
second flag/image you like but for this tutorial. I’ll
use Dobie and the flag of The Republic of
Seychelles (because it’s a cool flag). You can
download Dobie here: http://db.tt/moBIMg.
Use any flag you like, but this is the flag I’m using:
http://upload.wikimedia.org/wikipedia/commons/9/92
/Flag_of_the_Seychelles.svg.
Wikimedia commons is a great place to find flags!
http://commons.wikimedia.org/wiki/Main_Page.
3. When choosing an image/shape that the
flag will be clipped to, (such as Dobie or the
shape of a country), you’ll usually need to
use an SVG type image. If you use a PNG or
JPG, while it may look to be the shape of a
country, for example, it will actually have an
invisible rectangle around it. This means you
can’t clip it to the shape of the country. As
you will see, the Dobie image is an SVG
type image, and so is the Seychelles flag,
although it doesn’t need to be. The flag can
be PNG, JPG or any image format that
Inkscape supports, although for the best
results when resizing the flag, SVG is
recommended. Wikimedia commons is also
a great place to find SVG type images of
anything, not just flags. There are some
other great sites for SVG images, and I’ll
provide links for some of them at the end of
the tutorial.

Let’s get stuck in!
1. Download the Dobie image and the flag, and put
them on your desktop.
2. Click on Inkscape to open the application and
click the ‘shrink window’ button on the window frame
at the top, so you are viewing Inkscape in a smaller
window, and you can see part of the desktop behind
it.
3. Now drag and drop Dobie onto the Inkscape
canvas. Anywhere is ok. Before we go any further,
let’s get rid of that page you can see on the canvas,
because we won’t be needing it. Click on the
‘document properties’ button as shown in the screen
shot, and uncheck the 'show page border’ box.

Peru with the country’s flag clipped over it.

The shape of the country of Peru
with the flag clipped over it.

Dobie with the Australian flag
clipped over him.

http://db.tt/moBIMg
http://upload.wikimedia.org/wikipedia/commons/9/92/Flag_of_the_Seychelles.svg
http://commons.wikimedia.org/wiki/Main_Page
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4. Next, drag and drop your flag onto the canvas
somewhere near Dobie. You can now maximize the
Inkscape screen so that it fills the whole desktop.

5. If you are using Dobie and the same Seychelles
flag, you won’t need to do this next step, (because
they are both SVG images), but it is important to do
it if you are using any JPG or PNG images. You
need to go to the menu at the top and click on
Extensions > Images > Embed Images, then click
apply, then close the little 'Embed Images’ box. This
embeds the PNG, JPG etc. image into the code of
the SVG image so that it’s not still linking to the
saved image on your desktop.
6. Left click and hold, and drag the flag, and drop it
on top of Dobie.
7. Then click the 'lower selection to
bottom’ button which is in the
toolbar just above the ruler at the
top of the canvas. It looks a bit like
this.

This will drop the flag down to the bottom so that you
can see Dobie on top of the flag. If you added the
two images onto the canvas in the reverse order at
the beginning, Dobie may already be on top which is
fine.
8. To zoom in and out, use the up/down zoom keys
in the bottom right corner of the window.
9. As you can see, the flag is larger than Dobie, but
we want as much of the flag as possible to be
clipped onto Dobie. Let’s resize the flag so that it’s
closer to Dobie’s size. Click on the flag until you see
these arrow guides surrounding it.

There are two types of guides, so you may need to
click a couple of times until you get these particular
guides.
10. Next, holding down Shift + Control, click and
drag one of the corner arrows in towards the centre
of the flag until it is tight around the shape of Dobie.
You can click on the flag itself and drag it around if

you need to re­position it a little, or you can click and
drag Dobie around into a different position.

You can also drag any one of the arrow guides on
the sides of the flag if you need to adjust only one
side. For example, in this last screenshot, you could
click the right middle arrow guide on the flag and
drag it toward Dobie’s bum, but I’ve decided to leave
it where it is. **REMEMBER** The 'undo last
action’ button in the toolbar at the top is your
best friend!! It's very handy, if something goes
wrong. When you are happy with the placement of
both Dobie and the flag, it’s time to clip the flag.
11. Click somewhere on the white canvas and drag
a rectangle around both the flag and Dobie. This will
select both of them putting guide lines around both.
12. Now go to the menu at the top and click Object
> Clip > Set. Now you’re done!!
Your flag should now be clipped to the shape of
Dobie.

Clipping Objects Together To Create Cool Graphics With Inkscape
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13. Now that it’s done, there are a few things you
can do with it.
­ You can export the image to PNG format if you
want to use it just as it is on a forum or website.
­ You can drag a desktop wallpaper onto
the canvas and position/resize Dobie on
it, then run step 5 again and export it to
PNG format and use it for your desktop
wallpaper.
­ You can create a new wallpaper on the
canvas, position/resize Dobie on it and
export it to PNG format to use as your
desktop wallpaper like I’ve done in the
next screenshot. ­­­>
14. Exporting your image to PNG format
is easy. Select the image you’ve created
and go to the menu at the top. Click on
File > Export Bitmap. Then click

Selection, choose where you want to save
the image, and select Export.
I’ve been working on a project for while that
uses this technique. I’ve been clipping
various countries’ flags to the PCLinuxOS
text and have uploaded them to my blog.
So far I’m up to 27 flags, and more to come
if anyone asks for them. Check it out and
download them here:
http://timeth.wordpress.com/category/logos/
. OR, you could try to make one yourself!
Here’s an example:

Well, that’s it! I hope this tutorial was easy to
understand. If anything was unclear, please ask
questions on the forum in the Artwork and Theme
Requests section. There are people there who can
help.
Don’t forget to show off your creations in the Artwork
and Theme Requests or Screenshots sections on
the forum! See you there!

As I promised earlier, here are some sites where you
can download some SVG images:
http://www.clker.com
http://openclipart.org
http://commons.wikimedia.org/wiki/Main_Page
http://screencasters.heathenx.org (Fantastic video
tutorials here for Inkscape)

Clipping Objects Together To Create Cool Graphics With Inkscape

http://timeth.wordpress.com/category/logos/
http://www.clker.com
http://openclipart.org
http://commons.wikimedia.org/wiki/Main_Page
http://screencasters.heathenx.org
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by Paul Arnote (parnote)
I have a netbook, a laptop I carry in my briefcase,
two laptops that sit near my favorite spot in the living
room, a desktop computer in a spare bedroom that
runs my networked printer, and another desktop in
the basement that serves as my test box. There's
nothing more annoying, (to me, anyway), than
switching computers and not having access to all of
my favorite bookmarks in my web browser. Sure, I
could manually enter all those bookmarks, but
invariably some bookmarks will be left out. Let's not
mention all the work involved to try to enter all those
bookmarks manually on six different computers. It

also becomes virtually impossible to keep the
bookmarks on all six computers synced.
It's time to meet Xmarks. Originally named
FoXmarks, Xmarks allows you to sync your
bookmarks across multiple computers, automatically.
No fuss, no trouble. Just set it up and it keeps your
browser bookmarks synced and up­to­date across
all of your computers that you have Xmarks running
on.
Having broken away from its original exclusive
domain of working only with the Firefox web
browser, Xmarks also now works with Internet

Explorer, Safari (Mac only), and Google Chrome.
Despite requests for over a year now, the makers of
Xmarks have no plans to support the Opera web
browser any time soon. As you might expect, the
version of Xmarks for Firefox sports the most
features, since that's the browser where Xmarks got
its start. Here is a graphic (bottom of page) from the
Xmarks web site that gives a breakdown of the
features that are available under each browser.
One of the newest features of Xmarks is the ability
to sync open tabs in a browser across the various
computers you use. Simply activate the feature on
all the computers you use, and you can go from
computer to computer, and choose to open the
same tabs. Currently, this feature only works under
Firefox, Internet Explorer, and Chrome.
I've been mentioning throughout this review that
some feature are only available to users of the
Firefox web browser. Those exclusive features
include Smarter Search, User Your Own Server,
Secure Password Sync, Suggested Tags, and Site
Info. Only time will tell how many of those features
filter to the other supported browsers that are
capable of utilizing the Xmarks plug in.
Of course, the whole reason for installing the
Xmarks plug in is to sync all of your bookmarks
across multiple computers. This is something that
Xmarks does exceptionally well. What's best is that
Xmarks syncs your bookmarks in the background,
unobtrusively, and often times without you even
realizing that it's happening.
As an added benefit of using Xmarks, you literally
have total access to your regular bookmarks,

Firefox Add-ons: Xmarks Marks The SpotFirefox Add-ons: Xmarks Marks The Spot
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regardless of what computer you are using, and
regardless if that computer is running Xmarks or not.
If you are on a computer other than your own that
does not have Xmarks installed, you can simply go
to the Xmarks web site and log in with your Xmarks
username and password. Then, click on the "My
Bookmarks" link and all of your synced bookmarks
will be displayed in the browser window.

Installing Xmarks
To start with, head over to the Xmarks web site and
download the plug in for your browser. Alternatively,
you can often use the "find plugins tool" of your
favorite supported browser to download and install
the plug in. For the sake of brevity, I'm going to omit
some of the more obvious screens in the Xmarks
installation sequence.

The first screen you come to allows you to create an
Xmarks account, or to log into your existing one.
Since I already have an account, I've chosen to log
into my existing account. If you choose to set up a
new account, you will be given the opportunity to set
up that new account.

In the next screen, I provide my username and
password to the Xmarks server. Click on "Next" to
proceed.

Since I'm installing this under Firefox, I'm given the
opportunity to have Xmarks sync my passwords. My

personal choice is to opt out of having Xmarks store
my passwords, but your choice may be different.

You are then given an opportunity to enable the
newest feature of Xmarks, which is to enable
synchronization of open tabs. Again, my personal
choice is to opt out of this option, since I often have
different tasks underway on the various computers I
have running. So my choice is based on how I work
with my computers, and your choice may differ.

Firefox Add­ons: Xmarks Marks The Spot

http://www.xmarks.com/
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This is where the real activity takes place with
Xmarks. The default choice on this screen is to
merge the data on the server with the data on the
current computer. Since I already have an Xmarks
account and have things set up the way I like, I
chose to keep the data on the server, and discard
the data on the current computer. You may also
discard the data on the server, keeping only the
bookmarks on the current computer. If you're not
sure of what to choose, you can view your existing
bookmarks stored on the Xmarks server.

After displaying a warning message, presumably to
give you an opportunity to alter your choice of which
bookmarks to keep, Xmarks will sync your
bookmarks with the Xmarks server. A confirmation
web page will be displayed once your bookmarks
are successfully synced.

Xmarks Settings
Under the first tab, Status, you can view your
username, enter your password, tell Xmarks to
remember your password between sessions,

synchronize your bookmarks, or re­run the setup
wizard.

The second tab, Sync, allows you to choose which
items to sync using Xmarks, as well as a few
synchronization options.

Under the third tab, Restore, you can choose to
restore your bookmarks from a previous date. This,
of course, is handy if your bookmarks become
corrupted and sync before you realize the problem.

The fourth tab, Profiles, allows you to manage your
Xmark profiles.

Firefox Add­ons: Xmarks Marks The Spot
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The fifth tab, Discovery, allows you to specify the
Xmarks enhancements you want to employ when
searching sites, or bookmarking sites.

Under the sixth and last tab, Advanced, you can set
up whether or not you want to use encryption with
your Xmarks server connection. You can also force
overwriting the server data or the data on the current
computer.

Conclusion
Xmarks is one of those must­have browser plug ins,
at least for me. It has made the trap­riddled chore of
syncing my bookmarks across multiple computers
remarkably easy. It's done for me, without any
thought or effort on my part. This has freed me up to
tackle other tasks and pursue other interests ­ time
that would have otherwise have been spent syncing
my bookmarks.

Firefox Add­ons: Xmarks Marks The Spot

http://www.tuxmachines.org
http://www.linpc.us
http://www.linfx.com
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